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Günümüzde havacılık endüstrisi, teknolojik gelişmeler sayesinde büyük bir dönüşüm 

geçirmektedir. Bu dönüşümde, yolcu uçaklarındaki iletişim sistemlerinin güçlendirilmesi ve uçuş sırasında 

internet erişimi sağlanması önemli bir rol oynamaktadır. İnternet, hayatın birçok alanını etkilerken, seyahat 

sırasında da sürekli ve kesintisiz iletişim ihtiyacını karşılamak amacıyla havayolu taşımacılığında internet 

kullanımı önemli bir hale gelmiştir. "Havacılık Uygulamaları için Ka Bant Faz Dizinli Anten Tasarımı ve 

Jeosenkron Uydularla Performans Analizi" başlıklı bu tez, yolcu uçakları içerisinde internet erişimini 

optimize etmek amacıyla uçak ile potansiyel bir jeosenkron (GEO) haberleşme uydusu arasındaki iletişimi 

sağlayabilecek Ka Bant frekans aralığında mikroşerit dizi anten tasarımlarını ve simülasyonlarını 

içermektedir. 

GEO uydularının havacılık sektöründeki iletişim altyapısındaki rolü de oldukça önemlidir. GEO 

uyduları, geniş coğrafi bölgelere hizmet sağlama kapasitesi ve yüksek bağlantı sürekliliği ile bilinmektedir. 

Bu tez çalışması, GEO uyduların yolcu uçakları ile yer istasyonları arasındaki iletişimlerinin analizlerini 

içermektedir.  

 

Ka bant mikroşerit dizi antenler, yüksek frekanslı iletişim bantlarında geniş bant genişliği ve 

yüksek veri iletim hızları sunarak modern bir iletişim teknolojisi olarak öne çıkmaktadır. Bu antenlerin, 

yolcu uçaklarına entegre edilmesiyle birlikte, uçak içi iletişim sistemleri daha güçlü ve verimli bir hal 

almaktadır. Bu kapsamda tasarlanacak Ka bant faz dizinli mikroşerit anten tasarım optimizasyonları High 

Frequency Structural Simulator (HFSS) yazılımı kullanılarak gerçekleştirilecektir. Bu simülasyon 

programı, antenlerin, filtre içeren karmaşık RF devrelerinin ve iletim hatlarının tasarımında yaygın olarak 

kullanılan bir simülasyon programıdır. 

 

Tez kapsamında ayrıca Systems Tool Kit (STK) programı da kullanılarak potansiyel bir GEO uydu 

ile yolcu uçağı üzerine entegre edilmiş mikroşerit faz dizinli antenlerin haberleşme simülasyonları ve 

analizleri yapılacak ve link bütçesi analizleri gerçekleştirilmiştir. Tezde tasarlanan 18 - 21 GHz ve 26-31 

GHz frekans bandında çalışabilen iki adet faz dizinli mikroşerit anten, bu alanda yapılan iyileştirme 

çalışmalarına bir örnek teşkil etmektedir. Tezin sonuçları, havacılık endüstrisinin iletişim teknolojilerindeki 

gelişmelerine katkıda bulunmayı amaçlamaktadır. 

 

Havacılık endüstrisinin bu teknolojik gelişmelere uyum sağlaması, daha güçlü ve güvenilir iletişim 

sistemleri aracılığıyla seyahat deneyimini önemli ölçüde iyileştirebilir ve sektöre yeni olanaklar sunabilir. 

 

Anahtar Kelimeler: Anten, GEO, Ka Bant, Mikroşerit Faz Dizinli Anten, STK.  
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In today's aviation industry, a significant transformation is taking place thanks to technological 

advancements. In this transformation, strengthening communication systems in passenger aircraft and 

providing internet access during flights play a crucial role. While the internet influences many aspects of 

life, the use of the internet in air transportation has become increasingly important to meet the constant and 

uninterrupted communication needs during travel. This thesis, titled "Design of Ka-Band Phased Array 

Antennas for Aviation Applications and Performance Analysis with Geostationary Satellites," aims to 

optimize internet access within passenger aircraft by designing microstrip array antennas operating in the 

Ka-band frequency range that can facilitate communication between the aircraft and a potential 

geostationary (GEO) communication satellite. 

 

The role of GEO satellites in the communication infrastructure of the aviation sector is also highly 

significant. GEO satellites are known for their capacity to provide services over wide geographical areas 

and high connectivity. The thesis includes analyses of communication between passenger aircraft and 

ground stations using these satellites. 

 

Ka-band microstrip array antennas stand out as a modern communication technology, offering 

wide bandwidth and high data transmission rates in high-frequency communication bands. The integration 

of these antennas into passenger aircraft enhances the strength and efficiency of in-flight communication 

systems. The design optimization of Ka-band phased array microstrip antennas will be conducted using the 

High-Frequency Structural Simulator (HFSS) software. This simulation program is widely used for the 

design of antennas, complex RF circuits with filters, and transmission lines. 

 

Additionally, within the scope of the thesis, the Systems Tool Kit (STK) program will be utilized 

to perform communication simulations and analyses for microstrip phased array antennas integrated into a 

passenger aircraft with a potential GEO satellite. Link budget analyses have also been conducted. The two 

phased array microstrip antennas designed in the thesis, capable of operating in the 18-21 GHz and 26-31 

GHz frequency bands, serve as examples of improvement efforts in this field. The results of the thesis aim 

to contribute to the advancements in communication technologies in the aviation industry. 

 



 

 vi 

Adapting to these technological developments in the aviation industry can significantly enhance 

the travel experience through more robust and reliable communication systems, opening up new 

possibilities for the sector. 

 

Keywords: Antenna, GEO, Ka-Band, Microstrip Phased Array Antenna, STK. 
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1. GİRİŞ 

 

Antenlerin tarihi, insanlığın iletişim ihtiyaçlarına cevap verme çabasıyla başlar. 19. 

yüzyılın başlarında, telgraf sistemleri yaygınlaşırken, sinyallerin kablosuz olarak 

iletilmesi gereksinimi ortaya çıkmıştır. James Clerk Maxwell'in elektrik ve manyetik 

teorileri birleştirmesi ile elektromanyetik dalgalar teorik olarak ispatlanmıştır. Alman 

bilim insanı H. Rudolf Hertz'in elektromanyetik dalgaları deneysel olarak kanıtlaması 

sırasında ilk ilkel antenler kullanılmıştı. 20. yüzyıl başlarında Guglielmo Marconi'nin 

yaptığı haberleşme deneyleri sırasında ise ilk antenler aerial ismiyle kullanılmıştır. Bunlar 

daha çok basit teller ve çubuklar şeklindeydi ve genellikle iletim ve alım için aynı anten 

kullanılıyordu (Balanis, 2016). 

 

İkinci Dünya Savaşı sırasında, radar teknolojisinin gelişmesiyle birlikte anten tasarımları 

daha karmaşık hale gelmiş ve yönlendirilebilir anten sistemleri geliştirilmiştir. Savaş 

sonrasında, askeri uygulamalardan sivil alanlara anten teknolojisi hızla yayılmıştır. 

Televizyon yayıncılığı, mobil iletişim ve uydu haberleşmesi gibi alanlarda antenlerin 

önemi artmıştır. Bilgisayar destekli tasarım (CAD) ve RF (radyo frekans) 

mikroelektronik teknolojilerinin gelişimi, anten tasarımında büyük bir devrim yaratmış 

ve antenlerin boyutunu küçültmek, verimliliğini artırmak ve çoklu bantlarda çalışabilme 

yeteneklerini sağlamak için yeni olanaklar sunmuştur. Günümüzde, kablosuz iletişim 

teknolojilerinin hızla gelişmesiyle birlikte, 5G, IoT ve akıllı şehirler gibi alanlarda 

kullanılan antenlerin karmaşıklığı ve çeşitliliği giderek artmaktadır (Brown, 2019). Anten 

tasarımı ve teknolojisi, iletişim endüstrisindeki en önemli araştırma ve geliştirme 

alanlarından biri olarak devam etmektedir (Adams, 2017). 

 

Antenler, modern iletişim teknolojilerinin temel bileşenlerinden biridir ve elektriksel 

enerjiyi elektromanyetik dalgalar halinde iletmek veya almak için kullanılırlar. 

Antenlerin temel yapıları ve çeşitleri, geniş bir yelpazede bulunmaktadır. 

 

Antenlerin temel yapısı, genellikle radyo frekansı (RF) elemanı ve besleme hattı olmak 

üzere iki ana bileşenden oluşur. RF elemanı, antenin radyasyonunu sağlayan veya alınan 

sinyali işleyen yapıdır. Bu elemanlar, çeşitli geometrik şekillerde olabilirler ve farklı 

çalışma prensiplerine sahiptirler. Besleme hattı, RF elemanına enerji sağlayan veya 

antenden gelen sinyali alarak başka bir cihaza ileten bir iletişim hattıdır. Besleme hattı 
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genellikle koaksiyel kablo veya mikroşerit hattı şeklinde olabilir (Thompson & Nelson, 

2016). 

 

Anten çeşitleri arasında dipol antenler en basit olanlardır. Dipol antenler, bir iletkenin iki 

ucundan oluşur ve genellikle yatay veya dikey olarak yerleştirilirler. Geniş bir frekans 

aralığında kullanılabilmeleri nedeniyle radyo, televizyon gibi birçok alanda tercih 

edilirler. 

 

Yagi-Uda antenleri, bir dizi aktif ve pasif elemandan oluşur ve yönlendirilmiş radyo ve 

televizyon yayınlarında yaygın olarak kullanılırlar. Özellikle, televizyon alıcılarında ve 

radyo vericilerinde tercih edildiği dönemler olmuştur. Günümüz gelişen teknolojisinde 

kullanım alanı azalmıştır. 

 

Parabolik reflektör antenler, odak noktasında bir besleme elemanı olan bir reflektör ile 

karakterizedir. Çeşitli reflektör tipleri arasında parabolik, kare ve köşegen reflektörler 

bulunur. Bu antenler, yüksek kazançlı ve yönlendirilmiş sinyaller için idealdir. Parabolik 

reflektör antenler, yüksek kazançlı yönlendirilmiş sinyaller için idealdir ve uydu 

haberleşmesi, televizyon yayıncılığı, uzaktan algılama ve radar sistemleri gibi alanlarda 

kullanılırlar (Pozar, 2012).  

 

Helix Antenler: Spiral bir yapıya sahip olan helix antenler, genellikle yüksek kazançlı ve 

dar bantlı antenlerdir. Uydu iletişimi, RFID sistemleri ve hava radarları gibi 

uygulamalarda kullanılırlar. 

 

Logaritmik Periyodik Antenler (LPDA): Geniş bantlı ve yönlü bir radyasyon desenine 

sahip olan LPDA antenler, genellikle televizyon alıcıları ve radyo iletişimi gibi 

uygulamalarda kullanılır. 

 

Dielektrik Antenler: Dielektrik malzemelerden yapılan bu antenler, genellikle mikrodalga 

ve milimetre dalga bantlarında çalışır. Yüksek sıcaklık dayanımı ve düşük kayıpları 

nedeniyle radar sistemleri ve tıbbi görüntüleme gibi uygulamalarda tercih edilirler. 

 

Lens Antenler: Lens antenler, elektromanyetik dalgaları odaklamak ve yönlendirmek için 

dielektrik bir lens kullanır. Genellikle radar sistemleri ve mikrodalga haberleşme 

uygulamalarında kullanılırlar. 
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Her bir anten çeşidi, belirli bir kullanım alanına ve belirli bir performans gereksinimine 

yönelik olarak tasarlanmıştır, bu da iletişim teknolojilerindeki çeşitliliği ve ilerlemeyi 

yansıtmaktadır. 

 

Mikroşerit yama antenler, kompakt boyutları, düşük maliyetleri ve yüksek verimlilikleri 

nedeniyle birçok farklı uygulama alanında kullanılmaktadır. Bunlar arasında kablosuz 

iletişim sistemleri (WiFi, Bluetooth, GPS (Küresel Konumlandırma Servisi), cep 

telefonları, uydu iletişimi, radar sistemleri, tıbbi görüntüleme cihazları, havaalanı 

güvenlik tarama sistemleri ve endüstriyel otomasyon gibi alanlar bulunmaktadır (Zhang 

& Chen, 2015). Mikroşerit yama antenlerin bu çeşitli uygulama alanları, iletişim 

teknolojilerinin gelişmesinde ve günlük hayatımızda daha da yaygın hale gelmesinde 

önemli bir rol oynamaktadır (Young, 2015) (Ahmed & Hussein, 2017). 

 

Mikroşerit yama antenlerin önemi, taşınabilir cihazlarda ve yüksek frekanslı 

uygulamalarda kullanım kolaylığı ve etkinliğinden gelmektedir (Yang & Li, 2020). 

Küçük boyutları, antenlerin cihazlara kolayca entegre edilmesini sağlar ve düşük 

profilleri, cihazların tasarımında esneklik sunar (Peterson & Green, 2019). Ayrıca 

mikroşerit yama antenler, çeşitli frekans aralıklarında çalışabilirler ve bu da geniş bir 

uygulama yelpazesine sahip olmalarını sağlar. Bu antenlerin yüksek verimlilikleri, sinyal 

kalitesinin artırılmasına ve iletişim sistemlerinin performansının iyileştirilmesine katkı 

sağlar (Davis, 2018) (Evans, 2018). 

 

Mikroşerit yama antenlerin gelişimi, 20. yüzyılın ikinci yarısında mikrodalga 

teknolojisinin ve entegre devre tasarımının gelişmesiyle başlamıştır (Martin & Lee, 

2019). İlk olarak 1970'lerde geliştirilen mikroşerit yama antenler, düşük maliyetleri ve 

basit yapısı nedeniyle hızla popülerlik kazanmıştır. Bu antenlerin literatüre girişi, ilk başta 

araştırmacıların ve mühendislerin dikkatini çekmiş ve ardından birçok akademik 

çalışmada ve teknik dergide yayınlanmıştır. Gelişen teknoloji ve artan talep, mikroşerit 

yama antenlerin sürekli olarak yenilenmesine ve geliştirilmesine yol açmıştır (Kumar & 

Mehta, 2015) (Johnson, 2015). 

 

Günümüzde anten teknolojinin hızla gelişmesi, iletişim ve bilgi teknolojilerinde pek çok 

alanda çığır açıcı yeniliklere sebebiyet vermiştir (Smith & Doe, 2018). Özellikle havacılık 

sektöründe yaşanan gelişmeler, yolcu uçaklarının seyahat deneyimini zenginleştirmekte 

ve iletişim altyapısını daha da güçlendirmektedir (Richards, 2017) (Morgan & White, 
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2018). Bu bağlamda, kablosuz iletişim teknolojileri, yolculara uçak içinde kolaylıkla 

internet erişimi sağlamak ve uçuş sırasında iletişim kurmalarını mümkün kılmak adına 

önemli bir rol oynamaktadır (Thompson, 2016) (Dündar & Koyuncu, 2023). 

 

Bu tez, özellikle Ka bant frekansında tasarlanan alıcı ve verici mikroşerit dizi antenlerin 

kullanımıyla yolcu uçaklarında internet erişiminin sağlanabilmesi konusunu ele 

almaktadır. Ka bant mikroşerit dizi antenler, yüksek frekanslı iletişim bantlarındaki geniş 

bant genişliği ve yüksek veri iletim hızlarıyla öne çıkan modern bir teknolojidir (Parker 

& Miller, 2017) (Turner, 2017). Bu antenlerin, yolcu uçakları üzerinde kullanılmasıyla 

birlikte, uçak içi iletişim sistemleri daha güçlü ve verimli hale gelmektedir (Dündar & 

Koyuncu, 2023). 

 

 
Şekil 1: Uçak - Uydu Haberleşmesi Yapısı 

 

Ayrıca bu tezde uydu yer istasyonları ile uçaklar arasındaki iletişimi sağlamak üzere GEO 

uydularının kullanımını da incelenmektedir. GEO uyduları, geniş coğrafi bölgelere 

hizmet sağlama kapasitesi ve yüksek bağlantı sürekliliği ile bilinen uydular arası 
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iletişimde önemli bir rol oynamaktadır (Harris & Williams, 2016) (Ateş & Ürgün, 2017). 

Bu tez çalışmasında, yolcu uçakları ile yer istasyonları arasındaki iletişimde GEO 

uydularının avantajlarını değerlendirmekte ve bu teknolojinin havacılık sektöründeki 

potansiyel etkileri araştırılmaktadır. 

 

Bu bağlamda, tezin temel amacı, Ka bant mikroşerit dizi antenlerin yolcu uçaklarında 

internet erişimine olan etkisini incelemek ve GEO uydularının iletişim altyapısındaki 

rolünü anlamaktır. Yapılan analizler ile, havacılık endüstrisinde daha güçlü, güvenilir ve 

geniş kapsamlı iletişim sistemlerinin geliştirilmesine katkı sağlayarak, sektördeki 

paydaşlara değerli bir perspektif sunmak hedeflenmektedir. 
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2. KAYNAK ARAŞTIRMASI 

 

Kablosuz haberleşme günlük hayatta olmazsa olmazlarımız arasına girmiştir. Bu ihtiyaç 

hayatın her anında olduğu gibi yolculuklar esnasında da gerekliliğini göstermektedir. 

Kara ve deniz yolculuklarının yanı sıra özellikle hava yolculuklarında insanlar mobil 

cihazlarını kullanabilmeyi istemektedir (Dündar & Koyuncu, 2023). Bu sebeple 

günümüzde uçakların üzerine montajı yapılan ve uydu ile haberleşmesini sağlayan farklı 

çeşitlerde antenler mevcuttur (Balanis, 2016) (Chen & Gao, 2019) (Ford, 2019).  

 

Sreejith ve arkadaşları havayolu taşıtlarında kullanılmak üzere Ku bant aralığında 

çalışacak anten tasarımı çalışmaları gerçekleştirmiştir. Sistemi daha efektif kullanabilmek 

adına çift polarizasyona sahip dairesel yapıda bir mikroşerit dizi anten tasarımı 

gerçekleştirmişlerdir. Anten tasarımını katlanabilir bir yapıda oluşturarak uçak 

aerodinamiğine olan olumsuz etkiyi de minimize etmek amaçlanmıştır. 8x8 olarak 

tasarlanan antenin yama katmanı olarak RO4003C (ϵ𝑟 =3.55) seçilmiştir. Simülasyon 

sonuçlarında antenin 750 MHz bant genişliğine sahip olduğu ve portlar arası 

izolasyonunun 25 dB değerinden daha iyi olduğu görülmektedir (Sreejith, 2022).  

 

San Diago Üniversitesi’nden, Gultepe ve arkadaşları 2021 yılında, Ka bant (22.55-23.55 

GHz ve 25.5-27.5 GHz) frekans aralığını kullanarak 8 x 8 boyutlarında mikroşerit faz 

dizinli anten tasarımı gerçekleştirmişlerdir. Simülasyon sonuçlarına göre dairesel 

polarizasyonda 22 dBi kazanç elde edildiği görülen çalışmanın uydu haberleşme 

sistemlerinde kullanabilirliği analiz edilmiştir (Gultepe, 2021).  

 

Yine San Diego Üniversitesi’nden Sanghamitro ve arkadaşları 2023 yılında Ka bant 

frekans aralığını tercih edip çift bant haberleşme yapılabilen bir mikroşerit dizi anten 

tasarımı gerçekleştirmiştir. Bu anten 22.55-23.55 GHz ve 25.5-27.5 GHz frekans 

aralığında ışınım yapabilmektedir. Diğer çalışmalara benzer şekilde Sanghamitro’de 8x8 

tipte anten tasarımı yönünde tercih yapmıştır. Simülasyon sonuçları incelendiğinde 

antenin 23.05 GHz’de 21 dBi, 26.5 GHz’de 22.3 dBi kazanca sahip olduğu görülmüştür 

(Sanghamitro, 2023). 

 

Farklı bir çalışmada ise Martinez ve arkadaşları Ku bant frekansında 8x8 mikroşerit dizi 

anten sistemi geliştirmiştir. Bu çalışmanın diğer çalışmalardan ayırt edici özelliği; anten 

yapısalının kıvrılabilir/bükülebilir tipte olmasıdır. Bu tipte bir yapısal malzeme 
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seçmelerinin en önemli sebebi antenin uçak üzerine montajı yapıldığında aerodinamik 

açıdan olumsuz etkisinin olmamasının istenmesidir. Tasarlanan antenin üretimi de 

gerçekleştirilmiş olup bükülebilir yapısal ile testleri gerçekleştirilmiştir. Ayrıca 

simülasyon programı ile uçak modeli üzerine anten yerleşimi de yapılarak ışıma paterni 

analiz edilmiştir (Martinez-Vazquez, 2021).  

 

University of Delaware’den Zhang ve arkadaşlarının yayınladığı makalede Ka bant 

frekansında 4x4 faz dizinli anten tasarımlarını inceleyebiliriz. Bu çalışmada 35 GHz 

frekansında 6 dBi kazanca sahip bir sistem tasarlandığı görülmektedir. Anten sisteminin 

mikroşerit besleme ile yapıldığı ve aperture mikroşerit anten mantığı ile tasarımın 

gerçekleştirildiği görülmektedir. Bu sayede anten ışımasının daha iyi sonuçlar verdiği 𝑆11  

değerinin -35 dB seviyelerinde olduğu görülmektedir (Zhang, 2016).  

 

Kai Wei Low ve arkadaşları 2021 yılında, Ka bant frekansında hem gönderme hem de 

alma hatları için tasarladıkları iki farklı anten yapıları görülmektedir. Gönderme anteni 

1024 adet anten parçasından oluşmakta olup, çalışma frekansının 27-31 GHz olduğu 

analizlerde tespit edilmiştir. Bu antenin EIRP (Etkili İzotropik Yayın Gücü) değeri ise 

49,5 dBW olarak analiz edilmiştir. Benzer şekilde alma anteni de 1024 adet anten 

parçasından oluşmaktadır. 17,7 – 20,2 GHz bant genişliğine sahip alma anten sisteminin 

G/T (Gain / Temperature) değeri 8,1 dB/K olarak simülasyon programında ölçülmüştür. 

Bu çalışmalar ile gönderme ve alma anten sistemlerinin gerçeğe uyarlanabileceği ilgili 

EIRP ve G/T  değerleri ile ispatlanmıştır (Low, 2021a, 2021b).  

 

Reddy ve arkadaşlarının tasarladığı 16x16 ebatlarındaki Ka bant faz dizinli anteni 

inceleyecek olursak; aperture tipi yapı seçilmiş olup mikroşerit besleme yöntemi 

kullanılmıştır. Anten 24 – 26 dBi olarak analiz edilmiş olup Ka bant frekans aralığında 

gerçeğe uyarlanabilecek başarılı bir anten tasarımının yapıldığı görülmüştür (Reddy, 

2022). 

 

Faz dizinli anten veya hareketli anten sistemlerinde araştırılması gereken bir farklı konu 

ise uçak, otomobil, gemi vb. hareket halinde haberleşme sağlanmak istenen araçların 

üzerine yerleştirilen anten sistemlerinin uyduyu takip edebilme yetenekleridir. Bu konuda 

hareketli anten sistemlerinde anten platformu motorlu olup uydu takip sinyali referans 

alınarak motor kontrolü ile araçlar hareket halindeyken uydu takibi 

gerçekleştirilebilmelidir. Bu tip anten sistemlerinde anten ofset açısı ile sinyal seviyesi ve 
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anten paterni değişimleri incelenmektedir (Tsuji, 2014.). Faz dizinli anten sistemlerinde 

uydu takibi ise faz yönlendirmesinin yani theta açısındaki değişimin sinyal seviyesi 

üzerindeki etkisinin incelenmesi ile gerçekleştirilebilmektedir. Bu konuda da incelemeler 

mevcut olup, ± 60 derecelik açısal değişimde anten kazancında 4 dB’lik farklar görüldüğü 

Xue ve arkadaşları tarafından analiz edilmiştir (Xue, 2022).  

 

Antenler ile uydu takibi konusunda Ragnu ve arkadaşlarının yayınladıkları makalede, 

STK (Systems Tool Kit) analiz programı kullanılarak analizler yapılmıştır. Dünya 

üzerinde belirli bir noktadan GPS uydularının geçişleri analiz edilmiştir. Bu analizler 

sonucunda Hindistan bölgesinde yerleştirilen bir yer istasyonunun 2 günlük bir zaman 

aralığı içerisinde maksimum 11 minimum ise 4 GPS uydusunu aynı anda takip edebildiği 

simüle edilmiştir. Bağlı olunan GPS uydu sayısının yanı sıra uyduların haberleşme konisi 

içerisindeki süresi ile haberleşme konisi dışındaki süreleri de grafik analizler ile 

gösterilmiştir (Raghu & Manjunatha N, 2023).  

 

STK programı kullanılarak yapılan başka bir çalışmada ise Anupam ve arkadaşları 

jeosenkron bir uydunun Ka bant frekansındaki link bütçesi analizlerini gerçekleştirmiştir. 

İlgili anten, taşıyıcı, modülasyon vb. parametreleri STK programına girilmiştir. Uydu ve 

yer istasyonu anten ve alt sistem ekipmanlarının tanımlamaları 22 dBi kazançlı, 28 

GHz’de aşağı link olarak sisteme girilerek program içerisindeki kurulum tamamlanmıştır. 

Analizler sonucunda 3 boyutlu kazanç grafikleri ile link bütçesi çizelgeleri çıkarılmıştır. 

Çalışma sonucunda belirlenen parametreler ile ilgili anten ve yer istasyonu 

haberleşmesinin sağlanabileceği link bütçesi analizleri sonucunda görülmüştür (Sharma, 

2020).  
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3. MATERYAL VE YÖNTEM 

 

Bu tez kapsamında; materyal ve yöntem bölümü içerisinde ilk olarak Ka-Bant gönderme 

hattı (26-31 GHz) anteni tasarımı ile Ka-Bant alma hattı (18- 21 GHz) anteni tasarımları 

kapsamında tek yama anten tasarım detayları ve sonrasında mikroşerit dizi anten tasarım 

detayları ile teorik bilgileri verilmiştir. Teorik anten tasarım detaylarının ardından anten 

tasarımlarının gerçekleştirildiği ve simülasyonlarının yapıldığı HFSS (High Frequency 

Structural Simulator) programı tanıtımı yapılmış ve anten tasarımlarının bu program 

aracılığı ile nasıl gerçekleştirildiğinin detayları verilmiştir.  

 

Materyal ve yöntem bölümünün ikinci kısmında ise tasarım faaliyetleri gerçekleştirilen 

alma ve gönderme hattı antenlerin yolcu uçağı ile GEO uydu haberleşmesi kapsamında 

kullanılabilirliğinin belirlenebilmesi için hat bütçesi (link budget) hesaplamalarının teorik 

detaylarının incelenmesi ve sonrasında hat bütçesi hesaplarının ve uçak-uydu arası 

simülasyonların gerçekleştirildiği STK programının tanıtımı ve bu program aracılığı ile 

hat bütçesi simülasyonlarının nasıl gerçekleştirildiğinin detayları verilmiştir.  

 

3.1.  Mikroşerit Yama Anten Tasarım Parametreleri 

 

Mikroşerit yama anten tasarımı yapılırken ilk olarak yama antenin genişliği (W) değeri 

hesaplanır. W değerini hesaplayabilmek için anten için kullanacağımız malzemenin 

dielektrik sabiti (𝜀𝑟) ve antenin çalışma merkez frekansı (𝑓𝑟) değeri kullanılmaktadır 

(Robinson & Clark, 2016). Anten tasarımında havacılık ve uydu haberleşme sektörlerinde 

sıklıkla kullanılan 2.2 dielektrik sabiti değerine ve 1.575 mm kalınlığa sahip Rogers 

RT/Droid 5880 dielektrik malzemesi kullanılmıştır. Anten tasarımlarında dielektrik sabiti 

çok yüksek bir malzeme seçilirse ışıma düşük olacak, bant genişliği daralacak ve anten 

verimi düşecektir. Öte yandan dielektrik sabiti çok düşük (1’e yakın) olan bir malzeme 

seçilirse anten boyutu büyüyecektir. Dolayısıyla 2.2 dielektrik sabiti seçimi ile optimum 

seviyede bir malzeme seçimi yapılmıştır. 

 

Ayrıca bu parametrelere ek olarak serbest uzayın dielektrik sabiti (𝜀0), manyetik 

geçirgenliği, (µ0) W hesabı için gerekli diğer parametrelerdendir. Burada ışık hızı 𝑐0 =

3𝑥108𝑚/𝑠 olarak alınmıştır. 
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𝑊 =
1

(2𝑓𝑟√𝜇0𝜀0)
√

2

𝜀𝑟 + 1
=

𝑐0

2𝑓𝑟
√

2

𝜀𝑟 + 1
(3.1) 

 

W uzunluğunun hesaplanmasının ardından 
𝑊

ℎ
≥ 1 koşulu sağlandığı teyit edilip efektif 

dielektrik sabiti 𝜖𝑟𝑒𝑓𝑓 değeri 4.2 formülü kullanılarak hesaplanır (Liu & Yang, 2017). 

 

𝜖𝑟𝑒𝑓𝑓 =
𝜖𝑟 + 1

2
+

𝜖𝑟 − 1

2
 [1 +

12ℎ

𝑊
]

−
1
2

(3.2) 

 

Sonrasında 4.3 formülü kullanılarak efektif uzunluk değeri 𝐿𝑒𝑓𝑓 hesaplanır.  

 

𝐿𝑒𝑓𝑓 =
𝑐0

2𝑓𝑐√𝜖𝑟𝑒𝑓𝑓

(3.3) 

 

W, 𝜖𝑟𝑒𝑓𝑓 ve 𝐿𝑒𝑓𝑓 değerlerinin hesaplanmasının ardından mikroşerit anten uzunluğu olan 

L değerinin hesabı 4.4 ve 4.5 formülleri kullanılarak yapılmıştır.  

 

Δ𝐿 = 0,412 𝑥
(𝜖𝑟𝑒𝑓𝑓 + 0,3) (

𝑊
ℎ

+ 0,264) ℎ

(𝜖𝑟𝑒𝑓𝑓 − 0,258) (
𝑊
ℎ

+ 0,8)
(3.4) 

 

𝐿 =
𝑐0

2𝑓𝑐√𝜖𝑟𝑒𝑓𝑓

− 2Δ𝐿 (3.5) 

 

Anten tasarımı neticesinde mikroşerit antenin bant genişliğinin (BW) yüzde olarak (% 

BW) hesaplanması için ilk olarak antenin alt ve üst rezonans frekansları belirlenir. Bu 

frekanslar, antenin çalışma bant genişliğini oluşturur. Alt ve üst rezonans frekansları 𝑆11 

geri dönüş kaybı grafiğinde genellikle -10 dB altında kalan aralığın başlangıç ve bitiş 

frekansları olarak alınır.  

 

Alt ve üst rezonans frekanslarının bulunmasının ardından tasarım sonucunda elde edilen 

merkez frekansı 3.6 formülü ile belirlenir.  

 

𝑓𝑐𝑒𝑛𝑡𝑒𝑟 =
𝑓𝑙𝑜𝑤 + 𝑓ℎ𝑖𝑔ℎ

2
(3.6) 

 

Antenin mutlak bant genişliği (BW) 3.7 formülü ile hesaplanır. 
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𝐵𝑊 = 𝑓ℎ𝑖𝑔ℎ − 𝑓𝑙𝑜𝑤 (3.7) 

 

Buradan da yüzde bant genişliği (% BW) 3.8 formülü ile belirlenir.  

 

%𝐵𝑊 = (
𝐵𝑊

𝑓𝑐𝑒𝑛𝑡𝑒𝑟
) 𝑥100 (3.8) 

Ka – Bant ’ta çalışan tipik bir mikroşerit anten için bant genişliği genellikle şu aralıklarda 

olur: 

• Dar Bant Genişliği: %2 - %5 

• Geniş Bant Genişliği: %5 - %10 

 

Yapılan işlemler sonucunda Ka-Bant alma ve gönderme hatları için yapılan tek mikroşerit 

yama anten tasarım hesapları için kullanılan ve hesaplamalar sonucunda elde edilen 

değerleri içeren bilgiler Çizelge 1’de verilmiştir. 

 

Çizelge 1: Anten Tasarım Parametreleri 

 

Parametre 
Ka-Bant Gönderme Hattı 

Anteni 

Ka-Bant Alma Hattı 

Anteni 

Dielektrik Malzeme Rogers RT/Duroid 5880 Rogers RT/Duroid 5880 

 

W 2,97 mm 5,9 mm 

 

L 1,6 mm 3,9 mm 

 

𝜖𝑟 2,2 2,2 

 

ℎ 1,575 mm 1,575 mm 

 

𝑓𝑐 29.27 GHz 19 GHz 

 

Substrate X 15 mm 18 mm 

 

Substrate Y 10,3 mm 19,6 mm 

 

Bant Genişliği (BW) 1,29 GHz 1,61 GHz 

 

Yüzde Bant Genişliği 

(%BW) 

%4.4 %8.47 

 

Maksimum Kazanç 8,06 dBi 10,80 dBi 
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3.2. Mikroşerit Dizi Anten Tasarım Parametreleri 

 

Mikroşerit yama antenlerin tek başına kullanıldıkları pek çok uygulama olmasına karşın, 

birden fazla mikroşerit antenin birleştirilerek birlikte tasarlanması ve farklı 

uygulamalarda kullanımı mümkündür. Tek bir mikroşerit antenin yetersiz kaldığı 

performans kriterleri dizi mikroşerit anten yapısı ile elde edilebilir (Williams, 2018).  

 

Mikroşerit dizi antenler yüksek kazanç elde edilmesi ve yönlülük bakımından tek bir dizi 

antene kıyasla daha yüksek performansa sahiptir. Anten hüzme açısı ise tek mikroşerit 

antene kıyasla daha dardır. Mikroşerit dizi antenlerde kazanç ve yönlülük dizi anten sayısı 

ile doğrudan ilişkilidir (Lee & Kim, 2018). Anten sayısı arttıkça ışıma yoğunluğu da 

artacağından kazanç ve yönlülük de artar. Uydu haberleşmesi gibi uzak mesafe 

haberleşmeleri için dizi anten kullanımı oldukça avantajlı olmaktadır (Gonzalez, 2018). 

 

Dizi antenler birden fazla yama antenin birleşiminden oluştuğundan dolayı dizi anten 

tasarımlarında özdeş yama anten kullanımı tasarımı daha basit ve pratik hale getirecektir. 

Dizi antenlerin ışıma örüntüsünü etkileyen durumlar şunlardır (Hall & Thompson, 2020); 

 

• Her bir yama antenin fazı 

• Her bir yama antenin genliği 

• Her bir yama anten arası mesafe 

• Dizi anten tasarımının geometrik tasarımı 

• Her bir yama antenin ışıma örüntüsü 

 

Dizi anten tasarım konfigürasyonlarından bir tanesi dizi anten elemanlarının bir hat 

boyunca sıralı yerleştirilmesiyle oluşturulmaktadır. Bu yöntem oldukça basit ve pratik bir 

tasarım oluşturulması sağlamaktadır. Bu yöntemde dizi anten elemanlarının akımları aynı 

iken fazları farklı olmaktadır (Baker & Harris, 2016). Dizi antenin toplam alanı, tasarımda 

kullanılan her bir yama antenin oluşturduğu alanların vektörel toplamlarından 

oluşmaktadır. 
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Şekil 2: Doğrusal Dizi Anten Faz Diyagramı 

Şekil 2’de N elemanlı özdeş yama antenlerin z ekseni boyunca belirli bir aralıkta (d) 

yerleştirilerek dizi yapısı oluşturulmuştur. Örneğin 2 elemanlı bu dizi anten yapısı için 

ışıma yapan toplam elektrik alan 3.9 formülü ile hesaplanabilir (Balanis, 2016).  

 
𝐸𝑡 = 𝐸1 + 𝐸2 (3.9) 

 

Buradan her bir antenin uzak alan elektrik alanları toplamı 3.10 formülü ile elde edilebilir.  

 

𝐸𝑡 = 𝑎𝜃𝑗
𝐼0𝑙𝑘

4𝜋
𝑛0 [

𝑒
−𝑗[𝑘𝑟1−(

𝛽
2

)]

𝑟1
𝑐𝑜𝑠𝜃1 +

𝑒
−𝑗[𝑘𝑟2−(

𝛽
2

)]

𝑟2
𝑐𝑜𝑠𝜃2] (3.10) 

 

Burada 𝛽 yama antenler arası faz farkını ifade etmekte olup her iki anten için de aynıdır. 

Antenler arası mesafe d, uzak alan mesafe r’ye göre ihmal edilecek seviyededir. Bu 

yüzden genlik değişiklikleri için 3.11 ifadesi baz alınır. 

 

𝑟 ≅ 𝑟1 ≅ 𝑟2 (3.11) 

 

𝜃 ≅ 𝜃1 ≅ 𝜃2 (3.12) 
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Fakat faz değişiklileri için 3.13, 3.14 ve 3.15 ifadeleri kullanılarak toplam elektrik alan 

değeri 3.13 formülü ile hesaplanır. 

 

𝑟 ≅ 𝑟 −
𝑑

2
𝑐𝑜𝑠𝜃 (3.13) 

 

𝑟 ≅ 𝑟 +
𝑑

2
𝑐𝑜𝑠𝜃 (3.14) 

 

𝐸𝑡 = 𝑎𝜃𝑗
𝐼0𝑙𝑘

4𝜋
𝑛0𝑒−𝑗𝑘𝑟|𝑐𝑜𝑠𝜃| [𝑒

𝑗(𝑘𝑑𝑐𝑜𝑠𝜃+𝛽)
2 + 𝑒−

𝑗(𝑘𝑑𝑐𝑜𝑠𝜃+𝛽)
2 ] (3.15) 

 

𝐸𝑡 = 𝑎𝜃𝑗
𝐼0𝑙𝑘

4𝜋
𝑛0𝑒−𝑗𝑘𝑟|𝑐𝑜𝑠𝜃|2𝑐𝑜𝑠 [

1

2
(𝑘𝑑𝑐𝑜𝑠𝜃 + 𝛽)] (3.16) 

 

Dizi anten için toplam dizi faktörü değeri 3.17 formülü ile elde edilir. Alandaki toplam 

normalize dizi faktörü ise 3.18 formülü ile bulunur. 

 

𝐷𝐹 = 2 cos [
1

2
(𝑘𝑑𝑐𝑜𝑠𝜃 + 𝛽)] (3.17) 

 

𝐷𝐹𝑛 = cos [
1

2
(𝑘𝑑𝑐𝑜𝑠𝜃 + 𝛽)] (3.18) 

 

Buradan toplam elektrik alan, tek bir yama antenin referans noktasında oluşturduğu 

elektrik alan şiddeti ile dizi faktörünün çarpımı ile bulunabilir.  

 

𝐸𝑇 = 𝐸𝑡𝑒𝑘 𝑎𝑛𝑡𝑒𝑛 𝑥 𝐷𝐹 (3.19) 

 

Yukarıda belirtilen tüm ifadelerden de görüleceği üzere dizi faktörü dolayısıyla anten 

ışıma örüntüsü genlik farkı, faz farkı ve antenler arası mesafeden etkilenmektedir. 
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3.3. HFSS Simülasyon Programı 

 

HFSS, Ansys tarafından geliştirilen ve yüksek frekanslı elektronik ürünlerin tasarımı ve 

simülasyonu için kullanılan bir 3D elektromanyetik (EM) simülasyon yazılımıdır. 

Antenler, anten dizileri, RF veya mikrodalga bileşenleri, yüksek hızlı ara bağlantılar, 

filtreler, konektörler, IC paketleri ve baskılı devre kartları gibi geniş bir ürün yelpazesini 

analiz etmek için kullanılır (Wang & Li, 2020). 

 

HFSS Kullanım Alanları: 

 

• Anten Tasarımı: Mobil cihazlar, uydu iletişimi ve radar sistemleri gibi çeşitli 

uygulamalar için antenler tasarlamak ve optimize etmek için kullanılır. 

• RF ve Mikrodalga Bileşen Tasarımı: Filtreler, amplifikatörler, osilatörler ve 

karıştırıcılar gibi RF ve mikrodalga bileşenlerini tasarlamak ve optimize etmek 

için kullanılır. 

• Yüksek Hızlı Ara Bağlantı Tasarımı: Bilgisayar yongaları ve diğer elektronik 

cihazlar arasındaki yüksek hızlı bağlantıları tasarlamak ve optimize etmek için 

kullanılır. 

• Elektromanyetik Uyumluluk (EMC) Analizi: Ürünlerin elektromanyetik emisyon 

ve parazitlere karşı uyumluluğunu analiz etmek için kullanılır. 

• Biyomedikal Cihaz Tasarımı: MRI tarayıcıları ve implantlar gibi biyomedikal 

cihazların elektromanyetik alanlarını analiz etmek için kullanılır. 

 

Bu bölümde 10 GHz frekansında haberleşebilecek örnek bir probe beslemeli mikroşerit 

yama antenin tasarımının HFSS programı ile nasıl gerçekleştirildiği ve simüle edildiği 

incelenmiştir.  
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HFSS programı genel kullanıcı arayüzü Şekil 3’de görülmektedir. Kullanıcı arayüzünde 

genel olarak tasarım faaliyetlerinin gerçekleştirileceği 3D tasarım penceresi, tasarım 

faaliyetlerinde kullanılacak araçları içeren araç çubukları penceresi, proje genel 

faaliyetlerinin takip edileceği project manager penceresi ile özellikle penceresi ve 

komponent kütüphanesinin yer aldığı pencereler yer almaktadır.  

 

İlk olarak “Draw>Box” seçilerek anten dielektrik malzemesi çizimi yapılır. Burada 

önceden hesaplanan anten değerlerine göre göre Wg (x ekseni), Wl (y ekseni) ,h (z ekseni) 

ölçüleri girilir (Şekil 4). Sonrasında çizdiğimiz materyale sağ tıklayarak “Assign Material” 

seçilerek açılan menüden tasarımda kullanılacak olan dielektrik malzeme seçilir. Bu 

tasarım için Rogers RT/Duroid 5880 kullanılmıştır. Şekil 5’te materyal seçim ekranı 

gösterilmiştir.  

 

Şekil 3: HFSS Genel Arayüzü 



 

 

17 

 

Şekil 4: Dielektrik Malzeme Çizimi 

 

 

Şekil 5:Materyal Seçimi 

 

Dielektrik malzeme çizimi sonrasında toprak katmanı (ground plane) çizimi yapılır. Yine 

önceden hesaplanan değerlere göre “Draw > Rectangle “ seçilerek dielektrik malzemenin 

alt kısmına gelecek şekilde çizim yapılır. Hizalama işlemleri properties bölümünden 
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ayarlanır. Şekil 6’daki gibi dielektrik malzemenin altında olacak şekilde çizimi yapılır. 

“Assign Boundary > Finite Conductivity” menüsünden açılan pencerede malzeme 

“Copper (Bakır)” olarak seçilir.  

 

 

Şekil 6: Toprak Katı Çizimi 

 

Bir sonraki aşamada ise dielektrik malzeme üzerine patch (yama) anten eklenecektir. Bu 

işlem için önceki adımlarda olduğu gibi yama anten ölçülerinde çizim yapılır ve dielektrik 

malzeme üzerinde olarak şekilde yerleştirilir. Sonrasında ise materyal seçimi bakır olarak 

işaretlenir. Şekil 7’de yama anten çizimi ve ölçüleri gösterilmiştir. Yama anten ve toprak 

katı seçilerek “Assign Boundaries > Perfect E” seçilerek ışıma yapacak katmanlar olarak 

belirlenir.  
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Şekil 7: Yama Anten Çizimi 

 

Yama antenin de eklenmesinin ardından mikroşerit yama anteni besleyecek koaksiyel pin 

eklenmelidir. Bunun için koaksiyel probe’un toprak katı ile temas edeceği koaksiyel pin 

nokta toprak katından çıkarılır. Bu işlem için “Draw > Circle” seçilerek probe’un temas 

edeceği kısım çapında bir daire çizilir ve “Subtract” komutu ile toprak katından çıkarılır. 

“Draw > Cylinder” seçilerek probe boyutunda silindir çizilir. Probe içerisine aynı 

komutlar ile koaksiyel pin çizimi de gerçekleştirilir. İlgili silindir yapı seçilerek “HFSS > 

Excitations > Assign > Wave Port” seçilir. Koaksiyel probe çizimi Şekil 8’de 

gösterilmiştir.  
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Şekil 8: Koaksiyel Probe Çizimi 

 

Son olarak anteni test edeceğimiz ortamı oluşturmak gerekir. Bu işlem için antenin içinde 

kalacağı 3 boyutlu bir dikdörtgen prizma çizilir. Çizilen dikdörtgen prizma “Assign 

Boundary > Radiation” olarak ışımanın yapılacağı alan olan belirlenir. Malzeme seçim 

ekranından ise “air (hava)” seçilerek ortam belirlenmiş olur.  
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Şekil 9: Radyasyon Kutusu 

 

Tasarım işlemlerinin tamamlanmasının ardından simülasyon parametreleri ve 

ayarlamaları gerçekleştirilir. Project Manager menüsünden “Analysis > Add Solution 

Setup > Solution Frequency” kısmına antenin çalışma frekansı girilir. “Analysis > Add 

Frequency Sweep > Fast” seçilerek sonuçlar çıkartılırken 1-10 GHz aralığında 0.1 GHz 

aralıklar ile yazdırma işlemi yapılacağı burada belirlenir. Tercihe göre bu değerler 

tasarımcı tarafından değiştirilebilmektedir. Ayarlar tamamlandıktan sonra “Validate” 

seçilerek simülasyona hazır olup olmadığı kontrol edilir. Herhangi bir hata ile 

karşılaşılmadı ise “Analyze All” seçilerek simülasyon başlatılır. İstenilen sonuçları 

“Results” bölümü altında “Create” seçilerek oluşturulabilir. Örnek olarak oluşturulan geri 

dönüş kaybı (return loss – 𝑆11) ve kazanç (gain) grafikleri Şekil 10 ve Şekil 11’de 

gösterilmiştir.  
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Şekil 10: Mikroşerit Anten Kazanç Grafiği 

 

 

Şekil 11: Mikroşerit Anten S(1,1) Grafiği 
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3.4. Hat Bütçesi Tasarım Parametreleri 

 

RF link bütçesi, uydu haberleşmesi gibi uzak mesafe iletişim sistemlerinde iletim ve alım 

işlemlerinin başarılı bir şekilde gerçekleştirilebilmesi için gereken tüm parametrelerin 

analiz edilerek bir bütçe oluşturulmasıdır. Bu bütçe, sistemin başarılı bir şekilde 

çalışabilmesi için gerekli olan güç, sinyal seviyesi, bant genişliği ve diğer iletişim 

parametrelerini içerir (Kraus, Marhefka & Khan, 2002). RF (Radyo Frekansı) link 

bütçesi, uydu haberleşmesi gibi uzak mesafe iletişim sistemlerinde oldukça önemlidir 

çünkü iletişim sistemlerinin doğru bir şekilde çalışması için gereken minimum sinyal 

gücünü ve bant genişliğini belirler (Patel & Rao, 2017). RF link bütçesi hesaplamalarına 

ihtiyaç duyulmasının temel nedenleri şunlardır: 

 

Sinyal Kalitesi ve Güvenilirliği: Uydu haberleşmesi gibi uzak mesafe iletişim 

sistemlerinde iletilen sinyalin yeterli kalitede ve güvenilirlikte olması önemlidir. RF link 

bütçesi, iletişim sistemlerinin sinyal kalitesini sağlamak için gerekli olan minimum güç 

seviyesini belirler. 

Bant Genişliği Yönetimi: RF link bütçesi, iletişim kanallarının etkin bir şekilde 

yönetilmesini sağlar. Belirli bir bant genişliği içinde iletişim kanallarının verimli bir 

şekilde kullanılabilmesi için bant genişliği gereksinimlerini belirler. 

Maliyet ve Verimlilik: RF link bütçesi hesaplamaları, iletişim sistemlerinin maliyet 

etkinliğini artırır. Gereksiz güç ve bant genişliği kullanımını önleyerek, sistemlerin daha 

verimli çalışmasını sağlar.  

 

RF haberleşme genel yapısı Şekil 12’de gösterilmiştir. RF link bütçesi hesaplamaları için 

alıcı ve verici taraflarda aşağıdaki değerlere ihtiyaç duyulur: 

 

Verici Tarafta: 

• İletilecek sinyalin frekansı ve gücü 

• Anten kazancı ve yönelimi 

• Modülasyon türü ve verici ekipmanın özellikleri 

• Bozucu faktörler ve atmosfer koşulları 

 

Alıcı Tarafta: 
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• Alıcının hassasiyeti 

• Alıcının gürültü figürü 

• Alıcının bant genişliği gereksinimi 

• Alıcı anteninin kazancı ve yönelimi 

• Alıcı sisteminin diğer özellikleri 

 

 

Şekil 12: RF Haberleşme Genel Yapısı 

 

RF haberleşmesi kapsamında Şekil 12’de belirtilen parametreler şu şekildedir; 𝑝𝑡 = iletim 

hattı gücü (watt), 𝑝𝑟 = alıcı hat gücü (watt), 𝑔𝑡 = iletim hattı anten kazancı (dBi), 𝑔𝑟 = 

alıcı anten kazancı (dBi), 𝑟 = alıcı ve verici antenler arası mesafe (km). Bu bölümde 

gönderme hattı anteni bu tez çalışması kapsamında tasarlanan 8x8 faz dizinli Ka bant 

gönderme anteni, örnek bir GEO uydu üzerinde ise Ka bant alıcı anteni kullanılarak örnek 

teorik link bütçesi hesabı yapılacaktır.  

 

Tasarlanan antenin çalışacağı merkez frekans 𝑓𝑐 = 27,45 𝐺𝐻𝑧 olacaktır. İlk olarak 

çalışılacak frekanstaki dalga boyu 3.20 formülü ile bulunur. Burada 𝜆 dalga boyu, 𝑐0 ışık 

hızını ifade etmektedir.  

 

𝜆 =
𝑐0

𝑓𝑐
 (3.20) 

 

 

Buradan dalga boyu 0,0109 m olarak bulunur. Sonrasında hat bütçesinin önemli 

parametrelerinden biri olan EIRP değeri hesaplanır. EIRP, bir antenin belirli bir yönde 

verdiği radyasyon gücünü ölçer (Stutzman & Thiele, 2012). EIRP değeri 3.21 formülü ile 

hesaplanmaktadır.  
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𝐸𝐼𝑅𝑃 = 𝑃𝑡 + 𝐺𝑡 − 𝐿𝑡 (𝑑𝐵) (3.21) 

 

Burada 𝐿𝑡 gönderme hattı kaybını ifade etmektedir. Gönderme hattı çıkış gücü 27,2 dBW, 

anten kazancı 24,04 dBi ve 𝐿𝑡=0,2 dB alındığında EIRP değeri 51,04 dBW olarak 

bulunur. Bir başka parametre ise Güç Akı Yoğunluğu (Power flux density, PFD)’dur. Güç 

Akı Yoğunluğu, bir alan içindeki elektromanyetik enerji yoğunluğunu ölçen bir terimdir. 

Genellikle elektromanyetik dalgaların belirli bir noktadaki yoğunluğunu ifade etmek için 

kullanılır ve watt/metrekare (W/m²) ile gösterilir. Gönderme hattı anteninden uydu 

antenine ulaşan PFD değeri 3.22 formülü ile hesaplanır.  

 

PFD değerinin hesaplanması için uydu ile uçak arası mesafenin belirlenmesi 

gerekmektedir. Yolcu uçağı Konya lokasyonundan Barselona lokasyonuna doğru 

yolculuk yapacağından dolayı her iki konumda da uydu ile uçak arası mesafe farklı 

değerlerde olacaktır. Bu farklılık hat bütçesi tasarım parametrelerini etkileyecektir. 

Hesaplamalarda kullanılacak bilgiler Çizelge 2’de verilmiştir.  

 

Çizelge 2: Konya ve Barselona Kentleri İçin Parametreler 

 

Parametreler Değerler 

Enlem (Konya) 

 

37,87°K  

 

Boylam (Konya) 32,48°D 

Enlem (Barselona) 41,38°K 

Boylam (Barselona) 2,17°D 

Uydu Yörüngesi 41° D  

Dünya'nın yarıçapı (R) 6371 km 

GEO uydusunun yüksekliği (H)  35786 km 

 

İlk olarak Konya lokasyonu için uydu ile uçak arasındaki mesafe (slant range) 

bulunacaktır. Merkezi açı değeri (θ) 3.22 formülü ile elde edilir. Burada lat1için Konya, 
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lat2 için ise uydu enlem değerleri alınır. Uydu ekvatorda olduğundan lat2 = 0° olarak 

alınır. Δ𝑙𝑜𝑛𝑔 ise uydu boylamı ile Konya boylamı arasındaki farkı ifade etmektedir.  

 

cos(θ) = sin(lat1) sin(𝑙𝑎𝑡2) + cos(𝑙𝑎𝑡1) cos(𝑙𝑎𝑡2) cos(Δ𝑙𝑜𝑛𝑔) (3.22)

      = sin(37.87) sin(0) + cos(37.87) cos(0) cos(8.52)
 

Sonrasında uydu ile olan mesafeyi bulmak için 3.23 formülü kullanılır.  

 

𝑟 = √𝑅2 + (𝑅 + 𝐻)2 + 2𝑅(𝑅 + 𝐻) cos(θ) (3.23) 

 

Çizelge 2’deki değerler kullanıldığında Konya lokasyonu için slant range değeri 37396 

km olarak bulunur. Barselona için hesaplama yapacak olursak yine Çizelge 2, 3.22 ve 

3.23 formülleri kullanıldığında 38779 km olarak bulunur. Elde edilen mesafe değerleri 

kullanılarak 3.24 formülü ile Konya için (𝑃𝐹𝐷)𝑟  = −111,4 𝑤/𝑚2 ve Barselona için 

(𝑃𝐹𝐷)𝑟  = −111,72 𝑤/𝑚2 olarak hesaplanır. 

 

(𝑃𝐹𝐷)𝑟  =  𝐸𝐼𝑅𝑃 −  20 𝑙𝑜𝑔(𝑟) −  10.99 (3.24) 

  

Uçak ile uydu arasındaki RF sinyalinin iletiminde mesafeden kaynaklı sinyal kaybı 

oluşmaktadır. Serbest Uzay Kaybı (Free space path loss (FSPL)), elektromanyetik 

dalgaların serbest uzayda (boş alanda) seyahat ederken karşılaştığı sinyal zayıflamasını 

ifade eder (Patel & Singh, 2015). FSPL, elektromanyetik dalgaların bir kaynaktan bir 

alıcıya doğru yayıldığı durumlarda karşılaşılan doğal sinyal zayıflamasını ölçmek için 

kullanılır. Sistemdeki FSPL değeri 3.25 formülü ile hesaplandığında Konya için 𝐿𝐹𝑆(𝑑𝐵) 

= 210,01 dB, Barselona için ise 𝐿𝐹𝑆(𝑑𝐵) = 212,98 dB, olarak hesaplanır.  

 

𝐿𝐹𝑆(𝑑𝐵) =  20 𝑙𝑜𝑔(𝑓 ) +  20 𝑙𝑜𝑔(𝑟) +  32.44 (3.25) 

 

Her iki lokasyon için elde edilen serbest uzay kayıpları değerleri incelendiğinde Konya 

lokasyonu uyduya daha yakın konumda olduğundan kayıp daha az, Barselona lokasyonu 

uyduya daha uzak olduğundan dolayı ise yaklaşık 3 dB daha fazla kayıp oluşmaktadır. 

Her koşulda haberleşmenin kesintisiz bir şekilde devam etmesi hedeflendiğinden dolayı 

mesafe olarak Barselona için hesaplanan değerler işlemlerde kullanılacaktır. 
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Link bütçesi hesabı yapılırken sistemdeki tüm kayıplar hesaba katılmalıdır. FSPL’e ek 

olarak ITU-R P.618 standardı baz alınarak yağmur, bulut, sis gibi atmosferik kayıplar için 

1,71 dB, uygulama kayıpları için 0,25 dB ve anten hizalama kayıpları için 0,25 dB 

kayıplar da FSPL’e eklenerek 215,19 dB elde edilir (ITU, 2019).  

 

𝐿𝑇𝑜𝑡𝑎𝑙 = 𝐹𝑆𝑃𝐿 + 𝐿𝑎𝑡𝑚 + 𝐿𝑝𝑜𝑖𝑛𝑡𝑖𝑛𝑔 + 𝐿𝑖𝑚𝑝 = 215,19 𝑑𝐵 (3.26) 

 

Bütçe hesabında kullanılan bir diğer parametre olan sistem gürültü sıcaklığı (system noise 

temperature), RF haberleşme sisteminin toplam gürültüsünü temsil eder ve genellikle bir 

sıcaklık birimi olan Kelvin (K) cinsinden ifade edilir. Sistem gürültü sıcaklığı, iletim 

hattı, sky noise vb. sistemdeki tüm gürültü oluşturacak değerlerin toplamıdır ve sistemin 

performansını etkileyen önemli bir faktördür. Daha düşük bir sistem gürültü sıcaklığı, 

daha iyi bir sinyal-gürültü oranı (SNR) sağlar ve dolayısıyla iletişim veya algılama 

performansını artırır. GEO uydu üzerinde d=2m çapında ve 𝐺𝑟= 52,01 dBi kazanca sahip 

bir Ka bant alıcı anten kullanıldığı varsayılmıştır. Uydu üzerindeki anten ve alıcı sistem 

ekipmanları dahil toplam gürültü sıcaklığı değeri 𝑇𝑠𝑦𝑠 = 253,6 𝐾 olarak hesaplanmıştır.  

 

Alıcı anten tarafında sistem performansını ölçmek için G/T değeri hesaplanır. Bu terim, 

bir alıcı antenin (G) kazancını ve sistemin toplam gürültü sıcaklığını (T) ifade eder. 

Genellikle alıcı antenin kazancı, alıcı sistemin alabileceği sinyal gücünü artırmaya 

yardımcı olurken, sistem gürültü sıcaklığı, sistemin toplam gürültüsünü temsil eder. Uydu 

tarafındaki G/T değeri 3.27 formülü ile hesaplanmıştır.  

 
𝐺

𝑇
= 𝐺𝑟 −  10 𝑙𝑜𝑔10(𝑇𝑠𝑦𝑠) = 52,01 − 10 log(253,6) = 27,96 𝑑𝐵 (3.27) 

 

Bu aşamaya kadar RF link kurulumu kapsamında gerekli hesaplamalar yapıldı. Bu 

aşamadan sonra ise kurulan RF bağlantısının performans parametreleri incelenecektir. Bu 

ifade RF link üzerinden iletilecek verinin kalitesini, yeterli seviyede ve az hata oranı ile 

iletilip iletilemeyeceğine karar verdiğimiz kısımdır. Elde edilen verilere göre sistem için 

tasarlanmış faz dizinli anten sisteminin uçak – uydu arası haberleşme sistemlerinde 

kullanılıp kullanılamayacağına karar verilecektir.  

 

Performans parametrelerini hesaplamadan önce RF bağlantı ile iletilecek taşıyıcının 

özellikleri, veri hızı ve kapasitesi belirlenecektir. Bu kapsamda örnek olarak 50 Mbps veri 

hızı için QPSK modülasyonunda Reed-Solomon (239,255) kodlama ve 1/3 FEC değerine 
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sahip, %5 Roll-Off kapasiteli bir taşıyıcı için örnek bir hesaplama yapılacaktır. Sayısal 

haberleşme sistemlerinde önemli bir parametre olan sembol oranı hesaplanmalıdır. 

Sembol oranı bir sinyalde her saniyedeki sembol sayısını ifade eder. Bu semboller, veri 

taşıyan taşıyıcı RF sinyali üzerinde kodlanmış bilgiyi temsil eder. Sembol oranı, bir dijital 

iletişim sistemini karakterize etmek için önemlidir çünkü bir sistemdeki sembol oranı, o 

sistemin iletebileceği maksimum veri hızını belirler. Sembol oranı SR (Msps), net veri 

hızı DR (Mbps), hata düzeltme kodlaması FEC ve modülasyon katsayısı (QPSK için 

M=2) olmak üzere 3.28 formülü ile sembol oranı hesaplandığında 75 Msps değeri elde 

edilir.  

 

𝑆𝑅 (𝑀𝑠𝑝𝑠) =
𝐷𝑅

𝑀 ∗ 𝐹𝐸𝐶
(3.28) 

 

Taşıyıcı bant genişliği için ise %5 roll-off (RO) değeri işleme dahil edilir ve bant genişliği 

(BW) 3.29 formülü ile hesaplandığında 78,75 MHz olarak belirlenir.  

 

𝐵𝑊 (𝑀𝐻𝑧) = 𝑆𝑅 ∗ (1 + 𝑅𝑂) (3.29) 

 

Link bütçesi hesaplamaları yapılırken tüm işlemler dB biriminde hesaplandığı için elde 

edilen bant genişliği değerini de dB cinsine çevirmek gerekir. Bu işlem için 3.30 formülü 

kullanıldığında 𝐵𝑁=78,96 dBHz elde edilir.  

 

𝐵𝑁 = 10 ∗ log10(𝐵𝑊) (3.30) 

 

Performans parametreleri hesaplamalarında ilk olarak Taşıyıcı Gürültü Oranı (Carrier to 

Noise Ratio, C/N) değeri hesaplanır (Balanis, 2016). C/N bir sinyalin alındığı ortamdaki 

taşıyıcı sinyalin gücünün, aynı ortamdaki gürültü gücüne oranını ifade eder. Basitçe 

söylemek gerekirse, C/N sinyalin, arka plandaki gürültüye göre ne kadar güçlü olduğunu 

gösterir. Yüksek bir C/N daha net bir sinyal ve daha iyi bir alım kalitesini, düşük bir C/N 

ise sinyalin hata veya karışıklıklara daha duyarlı olabileceğini işaret eder. 

 

(
𝐶

𝑁
) = 𝐸𝐼𝑅𝑃 + (

𝐺

𝑇
) − (𝐿𝑓𝑠𝑝𝑙 + 𝐿𝑜𝑡ℎ𝑒𝑟 𝑙𝑜𝑠𝑠𝑒𝑠) − 228,6 − 𝐵𝑁 (3.31) 

 

Burada EIRP dBW, bant genişliği 𝐵𝑁 dBHz ve Boltzmann sabiti k=-228,6 dBW/K/Hz 

olarak 3.31 formülüne eklenir. İlgili değerler formülde yerine koyulduğunda C/N = 13,45 

dB bulunur. 
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C/N değerine benzer şekilde bir diğer performans parametresi olan C/N0 (Carrier to Noise 

Density), taşıyıcı sinyal gücünün (C) alınan sinyal gücüne (N0) oranıdır. Burada, N0, 

birim frekans başına düşen termal gürültü spektral yoğunluğunu ifade eder. C/N0 değeri 

3.32 formülü ile hesaplanabilmektedir. Buradan C/N0 değeri 92,41 dB bulunur. 

 

(
𝐶

𝑁0
) = (

𝐶

𝑁
) + 𝐵𝑁 (𝑑𝐵) (3.32) 

 

Bütçe hesaplarında hesaplanması gereken bir diğer parametre ise enerji bit başına gürültü 

oranı (Eb/N0), elektriksel sinyal gücünün her bit başına düşen gürültü spektral 

yoğunluğuna oranını ifade eden bir ölçümdür. Eb/N0, özellikle dijital modülasyon 

tekniklerinin tasarımı, değerlendirilmesi ve karşılaştırılmasında kullanılır. Ayrıca FEC 

(Hata Düzeltme Kodlaması) sistemlerinin performansını değerlendirmek için önemlidir.  

 

Sistem performansının sağlıklı bir şekilde değerlendirilebilmesi için sistemin ihtiyaç 

duyacağı minimum Eb/N0 değerinin ne olacağının belirlenmesi önem arz etmektedir. Bu 

bağlamda teorik Eb/N0 değeri ile sistemde elde edilen Eb/N0 değerlerinin 

karşılaştırılması ile sağlıklı bir değerlendirme yapılabilir. Sistemde 10−10 BER (Bit Error 

Rate) değerini sağlayacak bir yapı kurmak istediğimizi düşünürsek. Kullanılan QPSK 

modülasyonu için kodlamasız ve Reed-Solomon kodlamalı olacak şekilde iki farklı teorik 

Eb/N0 değeri Şekil 13’de gösterilmiştir. Ayrıca teorik Eb/N0 hesaplamaları için MATLAB 

kodları EK-1’de verilmiştir. 
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Şekil 13: Teorik Eb/N0 Değerleri 

 

Eb/N0 grafikleri incelendiğinde QPSK modülasyonunda herhangi bir kodlama 

kullanılmadığı takdirde sistemin en az 13,04 dB Eb/N0 değerine sahip olması gerektiği 

görülmektedir. Sistem performans ve verimliliğini artırmak amacıyla yapılan Reed-

Solomon kodlama ile aynı BER değerinde 7,94 dB Eb/N0 değerine sahip olmak yeterli 

olacaktır. Buradan yola çıkarak sistem marjin hesabı için kullanacağımız gereken Eb/N0 

=7,94 dB olarak alınacaktır. 

 

Bütçe hesabında son olarak tasarlanan anten sisteminin elde ettiği Eb/N0 değeri 

hesaplanacak ve sonrasında teorik değer ile kıyası yapılacaktır. 3.33 formülü aracılığı ile 

yapılan hesap sonucunda sistemin elde ettiği Eb/N0 değeri 21,19 dB olarak bulunur. 

 

(
𝐸𝑏

𝑁0
) =

𝐵𝑊

𝐷𝑅
∗ (

𝐶

𝑁
) (3.33) 

 

Son olarak teorik Eb/N0 ile alınan Eb/N0 değerleri için marjin hesaplanır.  

 

(
𝐸𝑏

𝑁0
)

𝑚𝑎𝑟𝑗𝑖𝑛

=  (
𝐸𝑏

𝑁0
)

𝑎𝑙𝚤𝑛𝑎𝑛

− (
𝐸𝑏

𝑁0
)

𝑡𝑒𝑜𝑟𝑖𝑘

= 21,19 − 7,94 = 13,25 𝑑𝐵 (3.34) 
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3.34 ifadesi ile elde edilen 13,25 dB marjin değeri sistem performansı için kabul 

edilebilecek minimum değerden 13,25 dB daha iyi olduğu anlamına gelmekte ve sistem 

tasarımının kabul edilebilir seviyede olduğunu göstermektedir.  

 

Uçak’tan GEO uyduya doğru iletilen RF taşıyıcı kapsamında yapılan link bütçesi 

hesaplamalarının özet bilgileri Çizelge 3’de gösterilmiştir. Gönderme ve alma antenleri 

kapsamında yapılacak tüm link bütçesi hesapları STK programında gerçekleştirilmiştir. 

Tez çalışmasının sonraki bölümlerinde STK programı üzerinden yapılan link bütçesi 

hesapları incelenecektir.  

 
Çizelge 3: Gönderme Hattı Link Bütçesi Özet Çizelgesi 

 

Parametre Sembol Değer 

Frekans 𝑓𝑐 27,45 GHz 

 

Dalga Boyu 𝜆 0,0109 m 

 

Uydu Mesafesi r 38779 km 

 

İletim Gücü 𝑃𝑡 27,20 dBW 

 

Gönderme Hattı Kaybı 𝐿𝑡 0,2 dB 

 

Gönderme Anteni Kazancı 𝐺𝑡 24,04 dBi 

 

Efektif İzotropik Alınan 

Güç 

EIRP 51,04 dBW 

 

Serbest Uzay Kaybı 𝐿𝐹𝑆 212,98 dB 

 

Atmosferik Kayıplar 𝐿𝑎𝑡𝑚 1,71 dB 

 

Hizalama Kayıpları 
𝐿𝑝𝑜𝑖𝑛𝑡𝑖𝑛𝑔 0,25 dB 

 

Uygulama Kayıpları 
𝐿𝑖𝑚𝑝 0,25 dB 

 

Toplam İletim Kaybı 𝑳𝑻𝒐𝒕𝒂𝒍 215,19 dB 

 

Güç Akı Yoğunluğu (𝑃𝐹𝐷)𝑟 -111,72 W/m2 

 

Alma Anteni Çapı 𝑑 2 m 

 

Alma Anteni Kazancı 𝐺𝑟 52,01 dBi 

 

Sistem Gürültü Sıcaklığı 
 

𝑇𝑠𝑦𝑠 
 

253,6 K 
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Gain / Temperature 
 

G/T 

 

27,96 dB 

 

Net Data Rate DR 50 Mbps 

 

Modülasyon Katsayısı QPSK 2 

 

Forward Error Correction FEC 1/3 

 

Roll – Off RO 0,05 % 

 

Sembol Oranı SR 75 Msps 

 

Bant Genişliği BW 78,75 MHz 

 

Teorik Eb/N0 
(

𝐸𝑏

𝑁0

)
𝑡𝑒𝑜𝑟𝑖𝑘

 13,04 dB 

 

Gerekli Eb/N0  

(Teorik + RS) 

(
𝑬𝒃

𝑵𝟎

)
𝒈𝒆𝒓𝒆𝒌𝒍𝒊

 7,94 dB 

 

Alınan Eb/N0 
(

𝑬𝒃

𝑵𝟎

)
𝒂𝒍𝚤𝒏𝒂𝒏

 21,19 dB 

 

Marjin 
(

𝑬𝒃

𝑵𝟎

)
𝒎𝒂𝒓𝒋𝒊𝒏

 13,25 dB 

 

3.5. STK Simülasyon Programı 

 

STK (Systems Tool Kit), mühendislik, savunma, havacılık ve uzay endüstrilerinde 

kullanılan kapsamlı bir yazılım paketidir. AGI (Analytical Graphics, Inc.) tarafından 

geliştirilen STK, sistemlerin modellenmesi, simülasyonu ve analizinde güçlü araçlar 

sunar. Bu yazılım, kullanıcılarına üç boyutlu görselleştirme, zaman bazlı analiz ve çeşitli 

fiziksel sistemlerin performans değerlendirmesi gibi imkanlar sunarak karmaşık 

görevlerin ve operasyonların planlanmasını ve yönetilmesini kolaylaştırır (AGI, 2022). 

 

STK, ilk olarak 1989 yılında piyasaya sürülmüştür. AGI'nin vizyonu, kullanıcıların 

karmaşık sistemleri modellemelerine, analiz etmelerine ve optimize etmelerine yardımcı 

olacak bir yazılım geliştirmekti. Yazılımın gelişimi, özellikle uzay ve savunma 

sektörlerindeki gereksinimlere yanıt olarak hız kazanmış ve zamanla daha geniş bir 

kullanıcı kitlesine hitap eden, modüler ve esnek bir platform haline gelmiştir. Bugün 

STK, dünya genelinde hükümetler, savunma kuruluşları, uzay ajansları, üniversiteler ve 

özel şirketler tarafından kullanılmaktadır. STK programının temel özellikleri ve işlevleri 

şu şekilde sıralanabilir:  
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• Üç Boyutlu Görselleştirme: STK, kullanıcıların uydu, uçak, gemi ve diğer 

araçların üç boyutlu görselleştirilmesini sağlar. Bu özellik, kullanıcıların 

karmaşık görevleri ve operasyonları daha iyi anlamalarına ve planlamalarına 

yardımcı olur. Görselleştirme araçları, gerçek zamanlı olarak veri sunar ve 

kullanıcıların senaryoları farklı perspektiflerden incelemelerine olanak tanır. 

 

• Zaman Bazlı Analiz: STK, kullanıcıların belirli bir zaman diliminde sistem 

performansını analiz etmelerini sağlar. Bu, özellikle görev planlaması ve senaryo 

analizi için kritiktir. Zaman bazlı analiz, farklı zaman dilimlerinde performansın 

nasıl değiştiğini görselleştirir ve kullanıcıların en iyi çözümleri geliştirmelerine 

yardımcı olur. 

 

• Modüler Yapı: STK, farklı modüller ile genişletilebilir. Her modül, belirli bir 

işlevselliği sağlar; örneğin, Uydu Modülü, yörünge hesaplamaları ve uydu görev 

planlaması için kullanılır. Diğer modüller arasında Hava Aracı Modülü, Deniz 

Aracı Modülü ve İletişim Modülü bulunur. Bu modüler yapı, kullanıcıların 

ihtiyaçlarına göre yazılımı özelleştirmelerini sağlar. 

 

• Entegre Fizik Motorları: STK, çeşitli fizik motorları ile entegre edilmiştir. Bu 

motorlar, atmosferik etkiler, yerçekimi, manyetik alanlar ve daha fazlasını dikkate 

alarak hassas simülasyonlar gerçekleştirir. Fizik motorları, gerçek dünya 

koşullarının modellenmesini sağlar ve sistemlerin performansını doğru bir şekilde 

tahmin eder. 

 

• Veri Entegrasyonu ve Analitik Yetenekler: STK, çeşitli veri kaynakları ile 

entegre olabilir ve kullanıcıların büyük veri kümelerini analiz etmelerine olanak 

tanır. Bu, sistem performansını optimize etmek ve karar verme süreçlerini 

desteklemek için kritik öneme sahiptir. 

 

STK programının kullanım alanları ise şu şekilde sıralanabilir:  

 

• Savunma ve Güvenlik: STK, askeri operasyonların planlanması ve simülasyonu 

için kullanılır. Özellikle uydu gözetimi, füze savunma sistemleri ve keşif 

görevlerinde önemli bir rol oynar. STK, düşman tehditlerini analiz etmek, karşı 

tedbirler geliştirmek ve operasyonel senaryoları simüle etmek için kullanılır. 
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• Havacılık ve Uzay: Havayolu şirketleri ve uzay ajansları, uçuş dinamiklerini 

analiz etmek, yörünge hesaplamaları yapmak ve uzay görevlerini planlamak için 

STK'dan yararlanır. NASA gibi kuruluşlar, uzay araçlarının yörünge belirleme ve 

izleme, görev planlaması ve operasyonel analizler için STK'yı kullanır. 

 

• Telekomünikasyon: Uydu iletişim sistemlerinin tasarımı ve performans analizi 

için STK kullanılır. Telekomünikasyon şirketleri, uydu konfigürasyonlarını 

optimize etmek, sinyal kapsamını analiz etmek ve sistem performansını 

değerlendirmek için bu yazılımdan faydalanır. 

 

• Akademik Araştırma: Üniversiteler ve araştırma kurumları, mühendislik ve 

bilimsel araştırmalarında STK'yı kullanarak karmaşık sistemlerin 

simülasyonlarını gerçekleştirirler. Akademik projelerde, STK, öğrencilere ve 

araştırmacılara gerçek dünya koşullarını simüle etme ve analiz etme fırsatı sunar. 

 

Bu bölümde uçak üzerine yerleştirilmiş 8x8 Ka Bant Faz Dizinli gönderme hattı anteni 

ile GEO uydu Ka bant alıcı anteni arasındaki link bütçesi hesaplarını ve simülasyonlar 

yapılacaktır. STK programı çalıştırıldıktan sonra açılan ekrandan “Create a Scenario” 

seçeneği seçilerek işleme başlanır. Ardından açılan “New Scenario Wizard” ekranında 

senaryo adı, açıklama, senaryonun başlangıç ve bitiş zamanları gibi kısımlar belirlenir. 

 

 

Şekil 14: STK Yeni Senaryo Oluşturma 

 

STK programı genel kullanıcı arayüzü Şekil 15’de görülmektedir. Kullanıcı arayüzünde 

genel olarak simülasyon ve tasarım faaliyetlerinin gerçekleştirileceği 3D simülasyon 

penceresi, 2D simülasyon penceresi tasarım faaliyetlerinde kullanılacak araçları içeren 
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araç çubukları penceresi, proje genel faaliyetlerinin takip edileceği nesne tarayıcısı 

penceresi ile proje zaman detaylarının yer aldığı ve yönetilebildiği zaman çizelgesi 

penceresi yer almaktadır. 

 

Şekil 15: STK Kullanıcı Arayüzü 

 

İlk olarak simülasyon çalışmalarında kullanacağımız uçak modelini eklemek için “Insert 

STK Object” menüsünden “Aircraft > Insert Default” seçilir. Object Browser menüsüne 

eklenen “Aircraft1” objesinin özellikler menüsüne girerek konfigürasyonlar tanımlanır. 

Burada uçak için tanımlamamız gereken ilk konfigürasyon uçağın hareket rotasıdır. 

Bunun için “Basic > Route” bölümüne gidilir. “Insert Point” seçilerek uçağın kalkış 

noktası konum bilgileri “LAT” “LON” cinsinden girilir. Tez çalışmasında kullandığımız 

rota olan Konya (KON) – Barselona (BCN) rotası için bilgiler girilmiştir. Konya 

lokasyonu için LAT: 37.8746 LON: 32.4931, Barselona için LAT:41.3850 LON: 2.1734 

olarak girilmiştir. Uçak rotasının belirlendiği pencere Şekil 16’da görülmektedir.  
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Şekil 16: Uçak Rotasının Belirlenmesi 

 

Bir sonraki aşamada uçak üzerine yerleştireceğimiz faz dizinli antenin parametrelerini 

girmek için “Insert Object > Antenna > Define Properties” seçilir. Açılan ekrandan anten 

tipi “Phased Array”, Çalışma frekansı: 27.45 GHz ve anten sayısı olarak 64 (8x8) 

girilmiştir.  

 

Antenden sonra uçak üzerinde bulunacak olan gönderici (Transmitter) bilgilerini girmek 

için de benzer şekilde “Insert Object > Transmitter > Define Properties” seçilir. “Type > 

Complex Transmitter Model” seçilerek transmitter parametreleri girilmeye başlanır. 

Burada Frekans 27.45 GHz, güç: 27.2 dBW, Data rate: 50 Mbps olarak seçilir. Önceden 

tanımlamasını yaptığımız antenimiz ile transmitter birimimizin birlikte çalışacağını 

belirtmek için “Antenna > Reference Type > Link” seçimi yapılır. Sonrasında 

modülasyon parametrelerinin tanımlamaları için “Modulator > name > QPSK” seçilir. 

Taşıyıcı boyutu girmek için ise “Signal Bandwith > Bandwith” seçilir ve 78.75 MHz 

olarak girdi yapılır. Son olarak sistemde modülasyonda yapılan kanal kodlama kazançları 

için girdi yapılır. Bu işlem için “Additional Gain and Losses” menüsünden kanal kodlama 

kazanç değenleri de eklenmiştir. Transmitter parametrelerinin girildiği pencere Şekil 17’de 

gösterilmiştir.  
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Şekil 17: Transmitter Parametrelerinin Girilmesi 

 

Uçak üzerinde tanımlanacak birimler bu aşama için yeterlidir. Şimdi ise GEO uydunun 

tanımlamaları yapılacaktır (Sanchez & Lopez, 2019). Bu işlem için “Insert Object > 

Satellite > Orbit Wizard” seçilir. Açılan menüden “Type > Geosynchronous” seçilir. 

Uydunun bulunduğu enlem değeri ve eğim değerleri “Definition > Subsatellite Point / 

Inclination” bölümünden girilebilmektedir. Enlem için 41 derece, eğim için 4 derece 

olarak değerler girilmiştir. Uydunun tanımlanmasının ardından uydu üzerinde bulunan 

alıcı anten eklenecektir. Bu işlem için “Insert Object > Antenna > Define Properties” 

seçilir. Uydu üzerindeki anten tipi olarak “Parabolic” ve anten çapı olarak 2m seçilir. 

Uydu alıcı anteni için tanımlamalar Şekil 18’de gösterilmiştir.  
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Şekil 18: Uydu Alıcı Anten Parametreleri 

 

Anten tanımlandıktan sonra uydu üzerindeki alıcı birimlerin parametrelerini girmek için 

benzer şekilde “Insert Object > Receiver” seçilerek “Type > Simple Model”, frekans 

27.45 GHz, G/T değeri 27,96 dB/K, “Link Margin: Enable” seçilir. “Demodulator” 

menüsünden ise “Auto-Select Demodulator” seçilerek alış hattı sinyalinin modülasyonu 

otomatik olarak seçilmiş olur. Alıcı birim parametrelerinin girildiği pencere Şekil 19’da 

gösterilmiştir.  
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Şekil 19: Alıcı Birimlerin Parametrelerinin Girilmesi 

 

Uçak üzerine yerleştirilen antenin uçağın rotası boyunca takip edebilmesi için ise “Insert 

Object > Sensor  > Define Properties” seçilir. Eklenen sensörün özellikler menüsünden 

“Pointing Type > Targeted ve Boresight Type: Tracking” olarak seçilir. İlgili sayfadan 

hedef olarak uydu üzerine yerleştirilien receiver ekipmanı seçilir. İlgili parametre 

ayarlarının yapıldığı ekran Şekil 20’de görülmektedir. 
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Şekil 20: Anten Takip Parametreleri 

 

STK ile Link Bütçesi hesaplama örneği kapsamında bu aşama için yeterli parametre ve 

ekipman eklenmiş bulunmaktadır. Şimdi ise link bütçesi hesaplarının simülasyonu 

gerçekleştirilecektir. Tüm ayarlamaların yapılmasının ardından araç çubuğu penceresi 

üzerinde bulunan “Start” butonu basılarak simülasyon başlatılır. 2D ve 3D simülasyon 

görselleri Şekil 21’de görülmektedir.  

 

 

Şekil 21: 2D ve 3D Simülasyon Ekranı 
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Şekil 22: Faz Dizinli Anten Uydu Takip Görseli 

 

Bu aşamadan sonra artık kurulan uydu haberleşme sisteminin performans 

değerlendirmelerini yapma aşamasına geçilebilir. Performans değerlendirmeleri 

kapsamında yapılacak link bütçesi hesapları için ilk olarak uçak ile GEO uydu arası 

bağlantının tanımlanması gerekmektedir. Bağlantıyı tanımlamak için Uçak üzerinde 

tanımlanan Transmitter seçili iken araç çubuğu bölümündeki “Access” aracı seçilir. 

Açılan pencereden hedef nokta olan uydu üzerindeki Receiver ekipmanı seçilir. Ardından 

“Reports > Link Budget” seçimi yapılır. Yapılan bağlantı kurma parametreleri ekranı Şekil 

23’de görülmektedir.  
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Şekil 23: Bağlantı Parametreleri 

 

Link bütçesi raporu çalıştırıldığında oluşan rapor görselleri Şekil 24 ve Şekil 25‘te 

görülmektedir. Şekiller incelendiğinde akı yoğunluğu, C/N0, C/N, alınan Eb/N0 

değerlerinin 3.4 Hat Bütçesi Tasarım Parametreleri bölümünde hesaplanan değerlere çok 

yakın olduğu görülmektedir. Bu da ilgili teorik hesaplamaların doğru olduğunu 

göstermektedir.  
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Şekil 24: Link Bütçesi - Kodlamasız (a) 

 

 

Şekil 25: Link Bütçesi - Kodlamasız (b) 

 

Hesaplamalar ile farklılık gösteren tek değer Eb/N0 değeridir. Eb/N0 değeri teorik 

hesaplamalarda 21,19 𝑑𝐵 olarak değerlendirilmesine rağmen STK simülasyonunda RS 

kodlama kazancı eklenmemiş hali gösterildiğinden bu değer elde edilmiştir. Buradaki 
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farklılık link bütçesi teorik hesaplamalarda kanal kodlamalarının kullanılarak daha 

verimli bir yapı kullanılmasıdır. STK üzerinde kanal kodlamaları seçilemeyip doğrudan 

QPSK modülasyonu seçilebildiğinden farklılık oluşmuştur. Bu hali ile de yeterli 

haberleşme performansını sağlayabilmektedir. Kanal kodlama kazançlarının STK 

simülasyonuna entegrasyonu için “Transmitter > Additional Gain and Lossses” bölümüne 

QPSK ile QPSK -RS arasındaki kazanç değeri elle girilmiştir. Şekil 13’te daha önce 

belirtilen Teorik Eb/N0 değerleri arasında 5,1 dB RS kazanç farkı olduğu belirtilmişti. 

Bu değer STK’da ilgili kısma girilerek Link Bütçesi raporu yeniden oluşturulduğunda 

Şekil 26’daki sonuçlar elde edilmiştir.  

 

 

Şekil 26: Link Bütçesi - Kodlamalı 

 

Buradan da görüleceği üzere kanal kodlama kazancı eklendiğinde Eb/N0 değeri 

20,92 𝑑𝐵 seviyelerine gelmiştir.  

 

  



 

 

45 

4. ARAŞTIRMA SONUÇLARI VE TARTIŞMA 

 

Bu tez çalışması kapsamında yolcu uçakları içerisinde internet kullanımının sağlanması 

amacıyla gönderme ve alma hattı için ayrı ayrı faz dizinli anten yapıları tasarlanmıştır. 

Gönderme ve alma hatları için Ka-Bant frekans aralığında dizi antenler tasarlanmıştır. 

Anten tasarımlarının performans değerlendirmeleri kapsamında hem gönderme hem de 

alma hattı antenleri için STK simülasyon ortamında haberleşme senaryosu ve link bütçesi 

analizleri yapılmıştır.  

 

4.1. Anten Tasarım Sonuçları 

 

Anten tasarımlarına ait sonuçlar bu başlık altında incelenmiştir. Bu kapsamda gönderme 

hattı için 26 – 31 GHz arasında, alma hattı için ise 18 – 21 GHz arasında haberleşme 

kabiliyetine sahip olacak anten tasarımları gerçekleştirilmiştir.  

 

4.1.1. Gönderme Hattı Anteni Tasarımı 

 

Ka-Bant gönderme hattı frekans aralığında (26 - 31 GHz) haberleşme kabiliyetine sahip 

antenler için tasarım faaliyetlerinin sonuçları bu başlık altında incelenmiştir. İdeal anten 

tasarımına ulaşabilmek adına ilk olarak tek yama anten tasarlanmış olup, sonrasında bu 

anten ile 1x2, 2x2, 4x4 ve 8x8 dizi anten yapıları oluşturulmuş ve bu geliştirme süreci 

kapsamında tespit edilen avantajlar ve dezavantajlar belirlenmiştir.  

 

4.1.1.1.Gönderme Hattı Tek Mikroşerit Yama Anten Tasarımı 

 

Ka-Bant gönderme hattında kullanılmak üzere ilk olarak tek yama anten tasarımı 

gerçekleştirilmiştir. Anten tasarımında dielektrik malzeme olarak 2.2 dielektrik sabitine 

sahip ve kalınlığı 1.575 mm olan Rogers RT Duroid 5880 kullanılmıştır. Rogers RT 

Duroid 5880 dielektrik malzemesinin özellikleri Çizelge 4’te verilmiştir. Mikroşerit 

besleme yöntemi ile tasarlanan yama anten görselleri Şekil 27, Şekil 28 ve Şekil 29’da 

görülmektedir.  

 



 

 

46 

Çizelge 4: Rogers RT Duroid 5880 Özellikleri 

Özellik Değer 
 

Dielektrik Sabiti (εr) 2,2  

 

Kayıt Faktörü (Dissipation Factor) 0.0009 (GHz başına) 
 

 

İletkenlik (Conductivity) 0.0009 S/m 
 

 

Kalınlık (Thickness) 1.575 mm (0.062 inç) 
 

 

Sıcaklık Katsayısı (Thermal Coefficient) 50 ppm/°C 
 

 

Maksimum İşlem Sıcaklığı 180°C (370°F) 
 

 

Tutkal Sıcaklığı (Glass Transition 

Temperature) 

280°C (536°F) 

 

 

Çalışma Sıcaklık Aralığı -55 / +125 °C 
 

 
 

 

 

 

 

Şekil 27: Tek Yama Anten Görünümü 
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Şekil 28: Tek Yama Anten Görünümü (üst) 

 

 

Şekil 29: Tek Yama Anten Görünümü (alt) 

 

Tek yama antenin çalışacağı frekans aralığını analiz etmek ve bu frekans aralığındaki 

iletim performansını görüntülemek için geri dönüş kaybı (return loss, 𝑆11) değeri Şekil 

30’da görülmektedir.  
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Şekil 30: Tek Yama Anten S(1,1) Grafiği 

  

Grafik incelendiğinde tek yama antenin 28,30 – 29,60 GHz frekans aralığında 1,3 GHz 

(%4,44) bant genişliğinde iletim yapabildiği ve 29,27 GHz merkez frekansından -15,44 

dB geri dönüş kaybına sahip olduğu görülmüştür.  

 

 

Şekil 31: Tek Yama Anten VSWR Grafiği 

 

Bir diğer önemli parametre ise duran dalga oranı (VSWR)’dır. Tek yama anten tasarımı 

sonucunda elde edilen VSWR değeri 26,21 GHz için 1,48 olarak elde edilmiştir. VSWR 
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grafiği Şekil 31’de görülmektedir. Antenin yönlendiriciliği (Directivity) ise Şekil 32’de 

görülmektedir.  

 

 

Şekil 32: Tek Yama Anten Directivity Grafiği 

 

Tasarlanan anten için 3 boyutlu kazanç grafiği Şekil 33’te görülmektedir. Bu analizden 

antenin 8,06 dBi kazanca sahip olduğu anlaşılmaktadır.  

 

 

Şekil 33: Tek Yama Anten Kazanç Grafiği 
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4.1.1.2.Gönderme Hattı 1x2 Dizi Anten Tasarımı  

 

Ka-Bant gönderme hattında kullanılmak üzere bir sonraki adım olarak 1x2 mikroşerit dizi 

anten tasarımı gerçekleştirilmiştir. Anten tasarımında aynı dielektrik malzeme 

kullanılmıştır. Mikroşerit besleme yöntemi ile tasarlanan yama anten görselleri Şekil 34, 

Şekil 35 ve Şekil 36’da görülmektedir. 

 

 

Şekil 34: 1x2 Mikroşerit Dizi Anten Görünümü 

 

 

Şekil 35: 1x2 Mikroşerit Dizi Anten Görünümü (üst) 
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Şekil 36: 1x2 Mikroşerit Dizi Anten Görünümü (alt) 

 

1x2 mikroşerit dizi antenin çalışacağı frekans aralığını analiz etmek ve bu frekans 

aralığındaki iletim performansını görüntülemek için geri dönüş kaybı (𝑆11) değeri Şekil 

37’de görülmektedir.  

 

 

Şekil 37: 1x2 Mikroşerit Dizi Anten S(1,1) Grafiği 

  

Grafik incelendiğinde 1x2 mikroşerit dizi antenin 24,18 – 31,45 GHz frekans aralığında 

7,27 GHz (%26,14) bant genişliğinde iletim yapabildiği ve 27,81 GHz merkez 

frekansından -18,67 dB geri dönüş kaybına sahip olduğu görülmüştür.  
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Şekil 38: 1x2 Mikroşerit Dizi Anten VSWR Grafiği 

 

1x2 mikroşerit dizi anten tasarımı sonucunda elde edilen VSWR değeri 29,68 GHz için 

1,44 olarak elde edilmiştir. VSWR grafiği Şekil 38’de görülmektedir. Antenin 

yönlendiriciliği (Directivity) ise Şekil 39’da görülmektedir.  

 

 

Şekil 39: 1x2 Mikroşerit Dizi Anten Directivity Grafiği 
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Tasarlanan anten için 3 boyutlu kazanç grafiği Şekil 40’ta görülmektedir. Bu analizden 

antenin 7,61 dBi kazanca sahip olduğu anlaşılmaktadır.  

 

 

Şekil 40: 1x2 Mikroşerit Dizi Anten Kazanç Grafiği 

 

4.1.1.3.Gönderme Hattı 2x2 Dizi Anten Tasarımı  

 

Ka-Bant gönderme hattında kullanılmak üzere bir sonraki adım olarak 2x2 mikroşerit dizi 

anten tasarımı gerçekleştirilmiştir. Anten tasarımında aynı dielektrik malzeme 

kullanılmıştır. Mikroşerit besleme yöntemi ile tasarlanan yama anten görselleri Şekil 41, 

Şekil 42 ve Şekil 43’te görülmektedir. 
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Şekil 41:2x2 Mikroşerit Dizi Anten Görünümü  

 

 

Şekil 42: 2x2 Mikroşerit Dizi Anten Görünümü (üst) 
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Şekil 43: 2x2 Mikroşerit Dizi Anten Görünümü (alt) 

 

2x2 mikroşerit dizi antenin çalışacağı frekans aralığını analiz etmek ve bu frekans 

aralığındaki iletim performansını görüntülemek için geri dönüş kaybı (𝑆11) değeri Şekil 

44’te görülmektedir.  

 

 

Şekil 44: 2x2 Mikroşerit Dizi Anten S(1,1) Grafiği 

  

Grafik incelendiğinde 2x2 mikroşerit dizi antenin 24,37 – 31,81 GHz frekans aralığında 

7,44 GHz (%26,75) bant genişliğinde iletim yapabildiği ve 27,81 GHz merkez 

frekansından -19,92 dB geri dönüş kaybına sahip olduğu görülmüştür.  
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Şekil 45: 2x2 Mikroşerit Dizi Anten VSWR Grafiği 

 

2x2 mikroşerit dizi anten tasarımı sonucunda elde edilen VSWR değeri 27,45 GHz için 

1,22 olarak elde edilmiştir. VSWR grafiği Şekil 45’te görülmektedir. Antenin 

yönlendiriciliği (Directivity) ise Şekil 46’da görülmektedir.  

 

 

Şekil 46: 2x2 Mikroşerit Dizi Anten Directivity Grafiği 
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Tasarlanan anten için 3 boyutlu kazanç grafiği Şekil 47’de görülmektedir. Bu analizden 

antenin 10,32 dBi kazanca sahip olduğu anlaşılmaktadır.  

 

 

Şekil 47: 2x2 Mikroşerit Dizi Anten Kazanç Grafiği 

 

4.1.1.4.Gönderme Hattı 4x4 Dizi Anten Tasarımı  

 

Ka-Bant gönderme hattında kullanılmak üzere bir sonraki adım olarak 4x4 mikroşerit dizi 

anten tasarımı gerçekleştirilmiştir. Anten tasarımında aynı dielektrik malzeme 

kullanılmıştır. Mikroşerit besleme yöntemi ile tasarlanan yama anten görselleri Şekil 48, 

Şekil 49 ve Şekil 50’de görülmektedir. 
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Şekil 48: 4x4 Mikroşerit Dizi Anten Görünümü 

 

 

Şekil 49: 4x4 Mikroşerit Dizi Anten Görünümü (üst) 
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Şekil 50: 4x4 Mikroşerit Dizi Anten Görünümü (alt) 

 

4x4 mikroşerit dizi antenin çalışacağı frekans aralığını analiz etmek ve bu frekans 

aralığındaki iletim performansını görüntülemek için geri dönüş kaybı (𝑆11) değeri Şekil 

51’de görülmektedir.  

 

 

Şekil 51: 4x4 Mikroşerit Dizi Anten S(1,1) Grafiği 

  

Grafik incelendiğinde 4x4 mikroşerit dizi antenin 24,61 – 32,18 GHz frekans aralığında 

7,57 GHz (%27,57) bant genişliğinde iletim yapabildiği ve 27,45 GHz merkez 

frekansından -16,65 dB geri dönüş kaybına sahip olduğu görülmüştür.  
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Şekil 52: 4x4 Mikroşerit Dizi Anten VSWR Grafiği 

 

4x4 mikroşerit dizi anten tasarımı sonucunda elde edilen VSWR değeri 27,45 GHz için 

1,34 olarak elde edilmiştir. VSWR grafiği Şekil 52’de görülmektedir. Antenin 

yönlendiriciliği ise Şekil 53’te görülmektedir.  

 

 

Şekil 53: 4x4 Mikroşerit Dizi Anten Directivity Grafiği 
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Tasarlanan anten için 3 boyutlu kazanç grafiği Şekil 54’te görülmektedir. Bu analizden 

antenin 17,22 dBi kazanca sahip olduğu anlaşılmaktadır.  

 

 

Şekil 54: 4x4 Mikroşerit Dizi Anten Kazanç Grafiği 

 

4.1.1.5.Gönderme Hattı 8x8 Dizi Anten Tasarımı 

 

Ka-Bant gönderme hattında kullanılmak üzere son adım olarak 8x8 mikroşerit dizi anten 

tasarımı gerçekleştirilmiştir. Anten tasarımında aynı dielektrik malzeme kullanılmıştır. 

Mikroşerit besleme yöntemi ile tasarlanan yama anten görselleri Şekil 55, Şekil 56 ve Şekil 

57’de görülmektedir. 
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Şekil 55: 8x8 Mikroşerit Dizi Anten Görünümü 

 

 

Şekil 56: 8x8 Mikroşerit Dizi Anten Görünümü (üst) 

 



 

 

63 

 

Şekil 57: 8x8 Mikroşerit Dizi Anten Görünümü (alt) 

 

8x8 mikroşerit dizi antenin çalışacağı frekans aralığını analiz etmek ve bu frekans 

aralığındaki iletim performansını görüntülemek için geri dönüş kaybı (𝑆11) değeri Şekil 

58’de görülmektedir.  

 

 

Şekil 58: 8x8 Mikroşerit Dizi Anten S(1,1) Grafiği 

  

Grafik incelendiğinde 8x8 mikroşerit dizi antenin 24,35 – 31,81 GHz frekans aralığında 

7,46 GHz (%27,17) bant genişliğinde iletim yapabildiği ve 27,45 GHz merkez 

frekansından -17,84 dB geri dönüş kaybına sahip olduğu görülmüştür.  

 



 

 

64 

 

Şekil 59: 8x8 Mikroşerit Dizi Anten VSWR Grafiği 

 

8x8 mikroşerit dizi anten tasarımı sonucunda elde edilen VSWR değeri 27,45 GHz için 

1,31 olarak elde edilmiştir. VSWR grafiği Şekil 59’da görülmektedir. Antenin 

yönlendiriciliği ise Şekil 60’da görülmektedir.  

 

 

Şekil 60: 8x8 Mikroşerit Dizi Anten Directivity Grafiği 
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Tasarlanan anten için 3 boyutlu kazanç grafiği Şekil 61’de görülmektedir. Bu analizden 

antenin 24,04 dBi kazanca sahip olduğu anlaşılmaktadır.  

 

 

Şekil 61: 8x8 Mikroşerit Dizi Anten Kazanç Grafiği 

 

4.1.2. Alma Hattı Anteni Tasarımı 

 

Ka-Bant alma hattı frekans aralığında (18 - 21 GHz) haberleşme kabiliyetine sahip 

antenler için tasarım faaliyetlerinin sonuçları bu başlık altında incelenmiştir. İdeal anten 

tasarımına ulaşabilmek adına ilk olarak tek yama anten tasarlanmış olup, sonrasında bu 

anten ile 1x2, 2x2, 4x4 ve 8x8 dizi anten yapıları oluşturulmuş ve bu geliştirme süreci 

kapsamında tespit edilen avantajlar ve dezavantajlar belirlenmiştir.  

 

4.1.2.1.Alma Hattı Tek Mikroşerit Yama Anten Tasarımı 

 

Ka-Bant alma hattında kullanılmak üzere ilk olarak tek yama anten tasarımı 

gerçekleştirilmiştir. Anten tasarımında dielektrik malzeme olarak gönderme hattı 

tasarımları için de kullanılan 2.2 dielektrik sabitine sahip ve kalınlığı 1.575 mm olan 

Rogers RT Duroid 5880 kullanılmıştır. Mikroşerit besleme yöntemi ile tasarlanan yama 

anten görselleri Şekil 62, Şekil 63 ve Şekil 64’de görülmektedir.  
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Şekil 62: Tek Yama Anten Görünümü 

 

 

Şekil 63: Tek Yama Anten Görünümü (üst) 
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Şekil 64: Tek Yama Anten Görünümü (alt) 

 

Tek yama antenin çalışacağı frekans aralığını analiz etmek ve bu frekans aralığındaki 

iletim performansını görüntülemek için geri dönüş kaybı (return loss, 𝑆11) değeri Şekil 

65’te görülmektedir.  

 

 

Şekil 65: Tek Yama Anten S(1,1) Grafiği 

  

Grafik incelendiğinde tek yama antenin 18,88 – 20,50 GHz frekans aralığında 1,62 GHz 

(%8,22) bant genişliğinde iletim yapabildiği ve 19,69 GHz merkez frekansından -19 dB 

geri dönüş kaybına sahip olduğu görülmüştür.  
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Şekil 66: Tek Yama Anten VSWR Grafiği 

 

Bir diğer önemli parametre ise duran dalga oranı (VSWR)’dır. Tek yama anten tasarımı 

sonucunda elde edilen VSWR değeri 19,62 GHz için 1,89 olarak elde edilmiştir. VSWR 

grafiği Şekil 66’da görülmektedir. Antenin yönlendiriciliği (Directivity) ise Şekil 67’de 

görülmektedir.  
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Şekil 67: Tek Yama Anten Directivity Grafiği 

 

Tasarlanan anten için 3 boyutlu kazanç grafiği Şekil 68’de görülmektedir. Bu analizden 

antenin 10,80 dBi kazanca sahip olduğu anlaşılmaktadır.  

 

 

Şekil 68: Tek Yama Anten Kazanç Grafiği 
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4.1.2.2.Alma Hattı 1x2 Dizi Anten Tasarımı  

 

Ka-Bant alma hattında hattında kullanılmak üzere bir sonraki adım olarak 1x2 mikroşerit 

dizi anten tasarımı gerçekleştirilmiştir. Anten tasarımında aynı dielektrik malzeme 

kullanılmıştır. Mikroşerit besleme yöntemi ile tasarlanan dizi anten görselleri Şekil 69, 

Şekil 70 ve Şekil 71’de görülmektedir.  

 

 

Şekil 69: 1x2 Mikroşerit Dizi Anten Görünümü 

 

 

Şekil 70: 1x2 Mikroşerit Dizi Anten Görünümü (üst) 
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Şekil 71: 1x2 Mikroşerit Dizi Anten Görünümü (alt) 

 

1x2 mikroşerit dizi antenin çalışacağı frekans aralığını analiz etmek ve bu frekans 

aralığındaki iletim performansını görüntülemek için geri dönüş kaybı (return loss, 𝑆11) 

değeri Şekil 72’de görülmektedir.  

 

 

Şekil 72: 1x2 Mikroşerit Dizi Anten S(1,1) Grafiği 

  

Grafik incelendiğinde 1x2 mikroşerit dizi antenin 18,08 – 20,10 GHz frekans aralığında 

2,02 GHz (%10,58) bant genişliğinde iletim yapabildiği ve 19,09 GHz merkez 

frekansından -30,49 dB geri dönüş kaybına sahip olduğu görülmüştür.  
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Şekil 73: 1x2 Mikroşerit Dizi Anten VSWR Grafiği 

 

1x2 mikroşerit dizi anten tasarımı sonucunda elde edilen VSWR değeri 19,34 GHz için 

1,07 olarak elde edilmiştir. VSWR grafiği Şekil 73’de görülmektedir. Antenin 

yönlendiriciliği (Directivity) ise Şekil 74’de görülmektedir.  

 

 

Şekil 74: 1x2 Mikroşerit Dizi Anten Directivity Grafiği 
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Tasarlanan anten için 3 boyutlu kazanç grafiği Şekil 75’te görülmektedir. Bu analizden 

antenin 12,55 dBi kazanca sahip olduğu anlaşılmaktadır.  

 

 

Şekil 75: 1x2 Mikroşerit Dizi Anten Kazanç Grafiği 

 

4.1.2.3.Alma Hattı 2x2 Dizi Anten Tasarımı  

 

Ka-Bant alma hattında kullanılmak üzere bir sonraki adım olarak 2x2 mikroşerit dizi 

anten tasarımı gerçekleştirilmiştir. Anten tasarımında aynı dielektrik malzeme 

kullanılmıştır. Mikroşerit besleme yöntemi ile tasarlanan dizi anten görselleri Şekil 76, 

Şekil 77 ve Şekil 78’de görülmektedir.  
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Şekil 76: 2x2 Mikroşerit Dizi Anten Görünümü 

 

 

Şekil 77: 2x2 Mikroşerit Dizi Anten Görünümü (üst) 
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Şekil 78: 2x2 Mikroşerit Dizi Anten Görünümü (alt) 

 

2x2 mikroşerit dizi antenin çalışacağı frekans aralığını analiz etmek ve bu frekans 

aralığındaki iletim performansını görüntülemek için geri dönüş kaybı (return loss, 𝑆11) 

değeri Şekil 79’da görülmektedir.  

 

 

Şekil 79: 2x2 Mikroşerit Dizi Anten S(1,1) Grafiği 

  

Grafik incelendiğinde 2x2 mikroşerit dizi antenin 18,14 – 20,50 GHz frekans aralığında 

2,36 GHz (%12,10) bant genişliğinde iletim yapabildiği ve 19,49 GHz merkez 

frekansından -32,47 dB geri dönüş kaybına sahip olduğu görülmüştür.  
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Şekil 80: 2x2 Mikroşerit Dizi Anten VSWR Grafiği 

 

2x2 mikroşerit dizi anten tasarımı sonucunda elde edilen VSWR değeri 19,29 GHz için 

1,15 olarak elde edilmiştir. VSWR grafiği Şekil 80’de görülmektedir. Antenin 

yönlendiriciliği (Directivity) ise Şekil 81’de görülmektedir.  

 

 

Şekil 81: 2x2 Mikroşerit Dizi Anten Directivity Grafiği 
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Tasarlanan anten için 3 boyutlu kazanç grafiği Şekil 82Şekil 75’de görülmektedir. Bu 

analizden antenin 14,90 dBi kazanca sahip olduğu anlaşılmaktadır.  

 

 

Şekil 82: 2x2 Mikroşerit Dizi Anten Kazanç Grafiği 

 

4.1.2.4.Alma Hattı 4x4 Dizi Anten Tasarımı  

 

Ka-Bant alma hattında kullanılmak üzere bir sonraki adım olarak 4x4 mikroşerit dizi 

anten tasarımı gerçekleştirilmiştir. Anten tasarımında aynı dielektrik malzeme 

kullanılmıştır. Mikroşerit besleme yöntemi ile tasarlanan dizi anten görselleri Şekil 83, 

Şekil 84 ve Şekil 85’de görülmektedir.  
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Şekil 83: 4x4 Mikroşerit Dizi Anten Görünümü 

 

 

Şekil 84: 4x4 Mikroşerit Dizi Anten Görünümü (üst) 
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Şekil 85: 4x4 Mikroşerit Dizi Anten Görünümü (alt) 

 

4x4 mikroşerit dizi antenin çalışacağı frekans aralığını analiz etmek ve bu frekans 

aralığındaki iletim performansını görüntülemek için geri dönüş kaybı (return loss, 𝑆11) 

değeri Şekil 86’da görülmektedir.  

 

 

Şekil 86: 4x4 Mikroşerit Dizi Anten S(1,1) Grafiği 

  

Grafik incelendiğinde 4x4 mikroşerit dizi antenin 18,12 – 20,50 GHz frekans aralığında 

2,38 GHz (%12,21) bant genişliğinde iletim yapabildiği ve 19,49 GHz merkez 

frekansından -32,91 dB geri dönüş kaybına sahip olduğu görülmüştür.  
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Şekil 87: 4x4 Mikroşerit Dizi Anten VSWR Grafiği 

 

4x4 mikroşerit dizi anten tasarımı sonucunda elde edilen VSWR değeri 19,56 GHz için 

1,08 olarak elde edilmiştir. VSWR grafiği Şekil 87’de görülmektedir. Antenin 

yönlendiriciliği (Directivity) ise Şekil 88’de görülmektedir.  

 

 

Şekil 88: 4x4 Mikroşerit Dizi Anten Directivity Grafiği 
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Tasarlanan anten için 3 boyutlu kazanç grafiği Şekil 89’de görülmektedir. Bu analizden 

antenin 21,66 dBi kazanca sahip olduğu anlaşılmaktadır.  

 

 

Şekil 89: 4x4 Mikroşerit Dizi Anten Kazanç Grafiği 

 

4.1.2.5.Alma Hattı 8x8 Dizi Anten Tasarımı  

 

Ka-Bant alma hattında kullanılmak üzere son adım olarak 8x8 mikroşerit dizi anten 

tasarımı gerçekleştirilmiştir. Anten tasarımında aynı dielektrik malzeme kullanılmıştır. 

Mikroşerit besleme yöntemi ile tasarlanan dizi anten görselleri Şekil 90, Şekil 91 ve Şekil 

92’de görülmektedir.  
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Şekil 90: 8x8 Mikroşerit Dizi Anten Görünümü 

 

 

Şekil 91: 8x8 Mikroşerit Dizi Anten Görünümü (üst) 
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Şekil 92: 8x8 Mikroşerit Dizi Anten Görünümü (alt) 

 

8x8 mikroşerit dizi antenin çalışacağı frekans aralığını analiz etmek ve bu frekans 

aralığındaki iletim performansını görüntülemek için geri dönüş kaybı (return loss, 𝑆11) 

değeri Şekil 93’te görülmektedir.  

 

 

Şekil 93: 8x8 Mikroşerit Dizi Anten S(1,1) Grafiği 

  

Grafik incelendiğinde 8x8 mikroşerit dizi antenin 18,18 – 20,50 GHz frekans aralığında 

2,32 GHz (%11,90) bant genişliğinde iletim yapabildiği ve 19,49 GHz merkez 

frekansından -33,03 dB geri dönüş kaybına sahip olduğu görülmüştür.  
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Şekil 94: 8x8 Mikroşerit Dizi Anten VSWR Grafiği 

 

8x8 mikroşerit dizi anten tasarımı sonucunda elde edilen VSWR değeri 19,53 GHz için 

1,03 olarak elde edilmiştir. VSWR grafiği Şekil 94’de görülmektedir. Antenin 

yönlendiriciliği (Directivity) ise Şekil 95’te görülmektedir.  

 

 

Şekil 95: 8x8 Mikroşerit Dizi Anten Directivity Grafiği 
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Tasarlanan anten için 3 boyutlu kazanç grafiği Şekil 96’da görülmektedir. Bu analizden 

antenin 28,24 dBi kazanca sahip olduğu anlaşılmaktadır.  

 

 

Şekil 96: 8x8 Mikroşerit Dizi Anten Kazanç Grafiği 

 

4.2. STK Simülasyon Sonuçları 

 

Yolcu uçağı ve GEO uydu arasındaki haberleşmenin sağlanabilmesi için alma ve 

gönderme hatlarında kullanılmak üzere 8x8 Ka-Bant mikroşerit dizi anten tasarımları 

gerçekleştirilmiştir. Tasarlanan antenlerin uçak ve uydu ile haberleşme simülasyonlarının 

ve link bütçesi analizleri STK programı ile gerçekleştirilmiştir. Bu kapsamda elde edilen 

sonuçlar bu bölümde incelenmiştir.  

 

4.2.1. Alma Hattı Hat Bütçesi Hesaplamaları  

 

GEO uydu tarafından gönderilen RF sinyallerinin uçak üzerindeki 8x8 Ka-Bant 

mikroşerit dizi anten aracılığı ile alınması kapsamındaki performans değerlendirmeleri 

bu başlık altında incelenmiştir. Alma hattı için tasarlanan dizi anten 18-21 GHz arasında 

çalışabilecek şekilde tasarlanmıştır.  

 

STK programında ilk olarak 41 derece doğu yörüngesinde aktif çalışan potansiyel bir 

GEO uydu tanımlanmıştır. GEO uydu üzerinde Ka-Bant alma hattı frekans bandında (18 

– 21 GHz) çalışan 23 dBi kazanca sahip bir anten kullanılmıştır. Alma hattı link bütçesine 
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ait parametreler Çizelge 5’te verilmiştir. Uydu yörüngesi ve genel uydu görselleri Şekil 97 

ve Şekil 98’de görülmektedir.  

 
Çizelge 5: Alma Hattı Link Bütçesi Parametreleri 

 

Parametre Sembol 
 

Değer 

Uydu Tipi SAT  Jeosenkron (GEO) 

 

Uydu Konumu SAT-LON 
 

41º Doğu 

 

Uydu Mesafesi r 
 

38779 km 

 

Uydu Tx Frekansı 𝑓𝑐 
 

19.49 GHz 

 

Uydu EIRP Değeri EIRP 
 

46,77 dBW 

 

Serbest Uzay Kaybı 

 

𝐿𝐹𝑆 

 

210,01 dB 

 

Atmosferik Kayıplar 𝐿𝑎𝑡𝑚 
 

1,06 dB 

 

Hizalama Kaybı 
𝐿𝑝𝑜𝑖𝑛𝑡𝑖𝑛𝑔 

 
0,25 dB 

 

Uygulama Kaybı 
𝐿𝑖𝑚𝑝 

 
0,25 dB 

 

Toplam Kayıp 𝑳𝑻𝒐𝒕𝒂𝒍 
 

211,56 dB 

 

Uçak Rx Anten Kazancı 𝐺𝑟 
 

28,24 dBi 

 

Sistem Gürültü Sıcaklığı 
 

𝑇𝑠𝑦𝑠 

 
213,4 K 

 

Uçak G/T Değeri 
 

G/T 

 
28,44 dB/K 

 

Net Veri Hızı DR 
 

100 Mbps 

 

Modülasyon Tipi QPSK 
 

QPSK 

 

Forward Error Correction FEC 
 

8/9 

 

Roll – Off  RO 
 

%5 

 

Taşıyıcı Bant Genişliği BW 
 

59,0625 MHz 
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Şekil 97: GEO Uydu Yörüngesi 

 

 

Şekil 98: GEO Uydu Genel Görünümü 

 

Haberleşme sistemi kapsamında bir diğer önemli araç olarak potansiyel bir yolcu uçağı 

tanımlanmıştır. Uçak üzerine alma hattı kapsamında tasarlanan Ka-Bant 8x8 mikroşerit 

dizi anten yerleştirilmiştir. Alma hattı kapsamında yolcu uçağı genel görünümü Şekil 99’da 

verilmiştir.  
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Şekil 99: Yolcu Uçağı Genel Görünümü 

 

Yolcu uçağı rotası olarak kalkış noktası Konya (KON) ve varış noktası Barselona (BCN) 

belirlenmiştir. Uçak rotası görünümü Şekil 100’de gösterilmiştir.  

 

 

Şekil 100: Uçak Rotası Genel Görünümü 
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Uçak ve uydu eklendikten sonra uydu üzerinde verici (transmitter) ekipmanı 

tanımlanmıştır. Verici ekipmanı için 23,97 dBW çıkış gücüne sahip multibeam (çoklu 

hüzme) bir yapı kullanılmıştır. Çoklu hüzme kullanılmasının sebebi yolcu uçağının 

konumunun sürekli değişken olmasıdır. Birden fazla hüzme kullanılarak uçak kalkış 

noktası olan Konya (KON)’dan varış noktası olan Barselona (BCN)’ya kadar 

haberleşmenin kesintisiz bir şekilde sağlanması amaçlanmıştır.  Uydu üzerinden Hüzme-

1 240 derece azimut, 84 derece elevasyon açısı ile Hüzme-2 ise 295 derece azimut, 85 

derece elevasyon açısı ile yönlendirildiğinde Konya – Barselona arası konumlarda yeterli 

kapsama alanına sahip olduğu görülmüştür. Kapsama alanları görüntüsü Şekil 101’de 

görülebilir.  

 

 

Şekil 101: Uydu Kapsama Alanları 

 

Yolcu uçağının Konya’dan Barselona lokasyonuna seyahati yaklaşık 4 saat sürmektedir. 

Yolculuk süresi boyunca uydu ile haberleşme sağlanan zamanlar, tasarlanan 8x8 dizi 

antenin yolculuk süresi boyuncu uyduyu takip etme süresi, azimut ve elevasyon açıları 

ile uydu mesafesi bilgileri Şekil 102’de gösterilmiştir.  
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Şekil 102: Uydu Takip Azimut Elevasyon Açıları Verileri 
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Yolculuğun tamamındaki azimut, elevasyon ve uydu mesafesi değişim grafiği ise Şekil 

103’de gösterilmiştir.  

 

 

Şekil 103: Yolculuk Süresi Boyunca Azimut, Elevasyon Açı Değişimleri 

 

Yolcu uçağının Konya – Barselona hattından farklı bir rotaya gitmesi halinde uydu 

haberleşmesi için analizler tekrarlanacak ve gerekmesi halinde alternatif çözüm önerileri 

oluşturulacaktır. Örneğin yolcu uçağı Konya – Lizbon seferini gerçekleşseydi Şekil 

101’den de görüleceği üzere uyduda tanımlanmış kapsama alanından uzaklaşma 

başlayacağı için sinyal seviyesinde azalma görülecektir. 41º Doğu yörüngesinde 

tanımlanan uydunun haberleşme performansının yeterli olmadığı lokasyonlarda farklı 

servis sağlayıcıları ile iş birliği yapılarak başka uydular üzerinden haberleşmenin 

yolculuk süresi boyunca devam etmesi ve sürekliliği sağlanabilir. Örnek olarak Lizbon 

lokasyonunda 7º Doğu yörüngesinde Ka Bant frekansında hizmet verebilen Eutelsat 7B 

uydusu kullanılabilir. Şekil 104’ten de görüleceği üzere Eutelsat 7B uydusunun Lizbon 

bölgesindeki kapsama alanının olduğu görülmektedir. Bu senaryoda yolcu uçağı Portekiz 

bölgesine yaklaştığında 41º ve 7º’deki uydu sinyalleri karşılaştırılacak ve sinyal seviyesi 

yetersiz kaldığında Eutelsat 7B uydusuna anahtarlama yapılarak haberleşme 

sürdürülecektir.   
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Şekil 104: Eutelsat 7B Kapsama Alanı 

 

Sonuç olarak STK ile yapılan analizler sonucunda potansiyel bir GEO uydusu ile 

potansiyel bir yolcu uçağı haberleşmesi amacıyla Ka-Bant alma hattı (18-21 GHz) 

kapsamında elde edilen link bütçesi analizi Şekil 105 ve Şekil 106’te gösterilmiştir. Bu 

Çizelgelerde link bütçesi performans değerlendirmelerinde önemli rol oynayan EIRP, 

Güç Akı Yoğunluğu, G/T, C/N0, Bant Genişliği, C/N, Eb/N0 ve BER değerleri elde 

edilmiştir.  
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Şekil 105: Alma Hattı Link Bütçesi Analiz Çizelgesi- 1 

 



 

 

94 

 

Şekil 106: Alma Hattı Link Bütçesi Analiz Çizelgesi- 2 
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4.2.2. Gönderme Hattı Hat Bütçesi Hesaplamaları 

 

Bu bölümde alma hattı için yapılan hat bütçesi analizlerine benzer olarak gönderme hattı 

için de benzer analizler yapılmıştır. Yolcu uçağı üzerine yerleştirilen 8x8 Ka-Bant 

mikroşerit dizi antenden gönderilen RF sinyallerinin GEO uydu tarafından alınması 

kapsamındaki performans değerlendirmeleri bu başlık altında incelenmiştir. Gönderme 

hattı için tasarlanan dizi anten 26-31 GHz arasında çalışabilecek şekilde tasarlanmıştır.  

 

Önceki bölümlerde STK programında 41 derece doğu yörüngesinde aktif çalışan 

potansiyel bir GEO uydu tanımlandığı aktarılmıştı. Benzer şekilde GEO uydu üzerinde 

Ka-Bant gönderme hattı frekans bandında (26 – 31 GHz) çalışan 52,01 dBi kazanca sahip 

bir anten kullanılmıştır. Gönderme hattı link bütçesine ait parametreler Çizelge 6’te 

verilmiştir. Uydu yörüngesi ve genel uydu görselleri Şekil 97 ve Şekil 98’de görülmektedir. 

 

Çizelge 6: Gönderme Hattı Link Bütçesi Parametreleri 

 

Parametre Sembol 
 

Değer 

Uydu Tipi SAT  Jeosenkron (GEO) 

 

Uydu Konumu SAT-LON 
 

41º Doğu 

 

Uydu Mesafesi r 
 

38779 km 

 

Uçak Tx Frekansı 𝑓𝑐 
 

27,45 GHz 

 

Uçak Tx Çıkış Gücü 𝑃𝑡 
 

27,20 dBW 

 

Uçak Tx Anten Kazancı 𝐺𝑡 
 

24,04 dBi 

 

Uçak Tx Hattı Kayıpları 𝐿𝑡 
 

0,2 dB 

 

Uçak EIRP Değeri EIRP 
 

51,04 dBW 

 

Serbest Uzay Kaybı 

 

𝐿𝐹𝑆 

 

212,98 dB 

 

Atmosferik Kayıplar 𝐿𝑎𝑡𝑚 
 

1,71 dB 

 

Hizalama Kaybı 
𝐿𝑝𝑜𝑖𝑛𝑡𝑖𝑛𝑔 

 
0,25 dB 

 

Uygulama Kaybı 
𝐿𝑖𝑚𝑝 

 
0,25 dB 

 

Toplam Kayıp 𝑳𝑻𝒐𝒕𝒂𝒍 
 

215,19 dB 
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Uydu Rx Anten Kazancı 𝐺𝑟 
 

52,01 dBi 

 

Sistem Gürültü Sıcaklığı 
 

𝑇𝑠𝑦𝑠 

 
253,6 K 

 

Uydu G/T Değeri 
 

G/T 

 
27,96 dB/K 

 

Net Veri Hızı DR 
 

50 Mbps 

 

Modülasyon Tipi QPSK 
 

QPSK 

 

Forward Error Correction FEC 
 

1/3 

 

Roll – Off  RO 
 

%5 

 

Taşıyıcı Bant Genişliği BW 
 

78,75 MHz 

 

Tanımlanan uydunun yanı sıra sistemdeki diğer önemli araç olan potansiyel bir yolcu 

uçağının STK programı üzerinde tanımlandığı da aktarılmıştı. Uçak üzerine gönderme 

hattı kapsamında tasarlanan Ka-Bant 8x8 mikroşerit dizi anten yerleştirilmiştir. 

Gönderme hattı kapsamında yolcu uçağı genel görünümü Şekil 99’da verilmiştir. Ek olarak 

yolcu uçağı rotasının kalkış noktası Konya (KON) ve varış noktası Barselona (BCN) 

olarak belirlendiği bilgisi de önceki bölümlerde aktarılmıştır. Uçak rotası görünümü Şekil 

100’de gösterilmiştir.  

 

Yolcu uçağı ve uydu araçları eklendikten sonra uçak üzerinde verici ekipmanı 

tanımlanmıştır. Verici ekipmanı için 27.2 dBW çıkış gücüne sahip bir yapı kullanılmıştır. 

Uçağın kalkış noktası olan Konya (KON)’dan varış noktası olan Barselona (BCN)’ya 

kadar haberleşmenin kesintisiz bir şekilde sağlanması amaçlanmıştır. Uydu üzerinden 

çoklu hüzme yöntemi ile yayın yapıldığı bilgisi de önceki bölümlerde verilmiş olup 

Konya – Barselona arası rotada yeterli kapsama alanına sahip olduğu görülmüştür. 

Kapsama alanları görüntüsü Şekil 101’de görülebilir.  

 

Konya’dan Barselona lokasyonuna seyahat yaklaşık 4 saat sürmektedir. Yolculuk süresi 

boyunca uydu ile haberleşme sağlanan zamanlar, tasarlanan 8x8 dizi antenin yolculuk 

süresi boyuncu uyduyu takip etme süresi, azimut ve elevasyon açıları ile uydu mesafesi 

bilgileri Şekil 102’de gösterilmişti.  

 

Gönderme hattı hat bütçesi analizleri kapsamında STK programı ile yapılan analizler 

sonucunda potansiyel bir GEO uydusu ile potansiyel bir yolcu uçağı haberleşmesi 
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amacıyla Ka-Bant gönderme hattı (26-31 GHz) kapsamında elde edilen link bütçesi 

analizi 

 

Çizelge 7 ve Çizelge 8’da gösterilmiştir. Bu Çizelgelerde link bütçesi performans 

değerlendirmelerinde önemli rol oynayan EIRP, Güç Akı Yoğunluğu, G/T, C/N0, Bant 

Genişliği, C/N, Eb/N0 ve BER değerleri elde edilmiştir.  
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Çizelge 7: Gönderme Hattı Link Bütçesi Analiz Çizelgesi - 1 
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Çizelge 8: Gönderme Hattı Link Bütçesi Analiz Çizelgesi - 2 
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5. SONUÇLAR VE ÖNERİLER 

 

5.1. Sonuçlar 

 

Bu tez çalışması, Ka-Bant alma ve gönderme frekans aralıklarında çalışabilecek faz 

dizinli mikroşerit antenlerin tasarım ve performans analizlerini içermektedir. Çalışmanın 

ana amacı, yolcu uçaklarında internet erişimini sağlamak için gerekli anten teknolojilerini 

geliştirmektir. Bu kapsamda hem gönderme hem de alma hatları için en uygun anten 

yapılandırmaları belirlenmiştir. Anten tasarım ve simülasyonları HFSS programı 

kullanılarak gerçekleştirilmiş olup tasarlanan antenlerin uydu ve yolcu uçağı senaryoları 

ile link bütçesi hesaplarının yapılarak çıktıları STK programında analiz edilmiştir.  

Gerçekleştirilen çalışmalar ve elde edilen sonuçlar detaylı olarak aşağıda 

açıklanmaktadır. 

 

5.1.1. Anten Tasarım Sonuçları 

 

Bu tez kapsamında gerçekleştirilen anten tasarımlarında faz dizinli mikroşerit dizi anten 

yapısı tercih edilmiştir. Hem haberleşme kapsamında hem de havacılık sektörü açısından 

değerlendirildiğinde mikroşerit antenler, ince ve hafif yapılarıyla uçak gibi taşıtlarda yer 

ve ağırlık tasarrufu sağlar. Bu, aerodinamik ve yakıt verimliliği açısından büyük bir 

avantajdır. Mikroşerit antenlerin üretimindeki kolaylık ve düşük maliyetli üretilebilmesi, 

kolayca entegre edilebilir olması gibi sebeplerden dolayı tercih edilmiştir.  

 

Öte yandan mikroşerit dizi antenlerin dielektrik kayıplara duyarlı oluşu ve dar bant 

genişliğine sahip olmaları gibi dezavantajları da bulunmaktadır. Anten tasarımlarında 

dielektrik sabiti çok yüksek bir malzeme seçilirse ışıma düşük olacak, bant genişliği 

daralacak ve anten verimi düşecektir. Öte yandan dielektrik sabiti çok düşük (1’e yakın) 

olan bir malzeme seçilirse anten boyutu büyüyecektir. Dolayısıyla 2.2 dielektrik sabitine 

sahip Rogers RT Duroid 5880 malzeme seçimi ile optimum seviyede bir seçim 

yapılmıştır. Bu malzeme düşük dielektrik kayıpları ile bilinir, bu da sinyalin daha az 

zayıflamasını sağlar ve anten verimliliğini artırır. RT Duriod 5880, yüksek frekanslarda 

stabil performans gösterir. Bu, yüksek frekanslı uygulamalar için kritik öneme sahiptir. 

Malzemenin termal kararlılığı, farklı sıcaklık koşullarında anten performansının sabit 

kalmasını sağlar. Rogers RT Duroid 5880 ürününün dezavantajı olarak maliyetli oluşu 
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değerlendirilebilir. Ancak antenin kritik bir görevde kullanılacağı ve uçak üzerinde 

konumlandırılacağı düşünüldüğünde bu durum göz ardı edilebilir.  

 

Alma ve gönderme hatları için tasarlanan antenlerin haberleşme frekans aralıkları Ka-

Bant (Tx: 26-31 GHz, Rx: 18-21 GHz) olacak şekilde tercih edilmiştir. Bu frekans 

bandının tercih edilmesinin sebepleri olarak yüksek kazanç, büyük bant genişliğinin 

sağlanması ilk sırada söylenebilir.  Bu da yüksek veri iletim hızları ve daha fazla kullanıcı 

kapasitesi anlamına gelir. Ayrıca Ka-Bant ticari uydu haberleşme sistemlerinde yaygın 

olarak kullanılır. Bu nedenle mevcut altyapılarla uyumludur ve bu frekansta çalışan 

ekipmanların bulunabilirliği yüksektir. Yüksek frekanslarda çalışmak, düşük 

frekanslardaki parazit ve gürültüden daha az etkilenme avantajını sağlar. Ayrıca Ka-Bant, 

küçük anten boyutlarıyla yüksek kazanç elde edilmesini mümkün kılar. Bu, özellikle uçak 

gibi yer sınırlaması olan ortamlarda büyük avantaj sağlar. Ka-Bant frekansının 

dezavantajı olarak ise atmosferik koşullara (yağmur, nem vb.) daha duyarlı olduğu ve bu 

durumun sinyal zayıflamasına sebebiyet verebileceği söylenebilir. Tasarlanan GEO uydu 

ve yolcu uçağı arasındaki haberleşme senaryosu için atmosferik kayıpların analizi 

yapılmış olup link bütçesi hesaplarına bu kayıplar dahil edilmiştir. Atmosferik kayıpların 

hesaplama detayları EK-2’de verilmiştir.  

 

Anten tasarımında tek bir mikroşerit anten yapısı yerine dizi anten yapısı kullanılmıştır. 

Dizi anten yapısı kullanılarak anten kazanç değerinin artırılması sağlanmıştır. Ek olarak 

faz dizinli bir yapı kullanılarak sağlanan yönlülük sayesinde sinyalin uyduya 

yönlendirilebilmesi ve yolculuk esnasında uydu takibi sağlanabilmektedir. Dizi 

antenlerin hüzmesi tek mikroşerit anten tasarımına kıyasla daha geniştir. Yüksek kazanç 

ve yönlülük özellikleri ile hüzme genişliği de değerlendirildiğinde sistem haberleşme için 

daha az enerji harcayacağından enerji verimliliği artacak ve sistem performansı ve 

güvenilirliğinin artması sağlanacaktır. 

 

Anten tasarımlarında gönderme hattı anteni tasarımı kapsamında Ka-Bant frekans 

aralığında (26-31 GHz) yüksek performanslı haberleşme antenlerinin tasarımı 

hedeflemiştir. Tek yama anten tasarımından başlayarak, sırasıyla 1x2, 2x2, 4x4 ve 8x8 

dizi anten yapılarında antenler tasarlanmıştır. Her bir aşamada, antenin kazancı, geri 

dönüş kaybı ve bant genişliği gibi kritik performans metrikleri optimize edilmiştir. 

Gönderme anteni tasarım sonuçları Çizelge 9’de belirtilmiştir.  
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Çizelge 9: Gönderme Hattı Antenleri Tasarım Sonuçları 

 

Anten 

Yapısı 

Çalışma Frekans 

Aralığı (GHz) 

Bant 

Genişliği 

(GHz) 

Yüzde Bant 

Genişliği 

(%BW) 

𝑺𝟏𝟏 Değeri 

(dB) 
VSWR 

Kazanç 

(dBi) 

Tek 28.30 – 29.60 1.3 4,44 -15.44 1.48 8.06 

1x2 24.18 – 31.45 7.27 
 

26,14 -18.67 1.44 7.61 

2x2 24.37 – 31.81 7.44 
 

26,75 -19.92 1.22 10.32 

4x4 24.61 – 32.18 7.57 
 

27,57 -16.65 1.34 17.22 

8x8 24.35 – 31.81 7.46 
 

27,17 -17.84 1.31 24.04 

 

Tek yama anten tasarımında, başlangıçta 8,06 dBi kazanç ve 1,3 GHz (%4,44) bant 

genişliği gözlenmiştir. 1x2 dizi yapısı oluşturulduğunda ise kazanç bir miktar 

gerilemesine rağmen bant genişliği 7,27 GHz (%26,14) seviyelerine çıkmıştır. 2x2 yapısı 

oluşturulduğunda bant genişliği bir miktar daha artarak 7,44 GHz (%26,75) seviyesine 

yükselmiştir. Anten kazancı ise 10,32 dBi seviyesine çıkmıştır. Haberleşme sisteminde 

kullanılacak seviyede anten tasarımı hedeflendiğinden dolayı dizi yapısı büyütülmeye 

devam edilmiş ve 4x4 yapısı oluşturulmuştur. 4x4 yapıda bant genişliği bir önceki antene 

kıyasla 130 MHz daha artarak 7,57 GHz (%27,57) seviyesine gelmiştir. Anten kazancı 

ise bir önceki yapıya kıyasla oldukça yüksek seviyede artarak 17,22 dBi değerine 

yükselmiştir. Son olarak 8x8 dizi anten tasarımında, antenin kazancı önemli ölçüde 

artırılmış 24,04 dBi seviyesine çıkmıştır. Bant genişliği 7,46 GHz’e (%27,17) çıkması ile 

daha da iyileştirilmiştir. VSWR değerleri karşılaştırıldığında ise 8x8 yapıya doğru 

gidildikçe stabil olan bir yapıya doğru gidildiği ve 1,31 değerinde elde edildiği 

görülmektedir. Bu oran duran dalga oranını ifade ettiğinden anten verimliliğinin 

sağlanabilmesi adına düşük olması tercih edilmektedir. Sonuç olarak 8x8 dizi anten 

yapısında 24,35 – 31,81 GHz bant genişliğinde haberleşme yapabilecek yüksek kazançlı 

anten tasarımı tamamlanmıştır.  

 

Anten tasarımlarında alma hattı anteni için yapılan tasarımlar kapsamında Ka-Bant 

frekans aralığında (18-21 GHz) yüksek performanslı haberleşme antenlerinin tasarımı 

hedeflemiştir. Gönderme hattında olduğu gibi tek yama anten tasarımından başlayarak, 

sırasıyla 1x2, 2x2, 4x4 ve 8x8 dizi anten yapılarında antenler tasarlanmıştır. Her bir 

aşamada, antenin kazancı, geri dönüş kaybı ve bant genişliği gibi kritik performans 

metrikleri optimize edilmiştir. Alma anteni tasarım sonuçları Çizelge 10’da belirtilmiştir.  
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Çizelge 10: Alma Hattı Antenleri Tasarım Sonuçları 

 

Anten 

Yapısı 

Çalışma Frekans 

Aralığı (GHz) 

Bant 

Genişliği 

(GHz) 

Yüzde Bant 

Genişliği  

(% BW) 

𝑺𝟏𝟏 

Değeri 

(dB) 

VSWR 
Kazanç 

(dBi) 

Tek 18.88 – 20.50 1.62 8,22 -19.00 1.89 10.80 

1x2 18.08 – 20.10 2.02 
 

10,58 -30.49 1.07 12.55 

2x2 18.14 – 20.50 2.36 
 

12,10 -32.47 1.15 14.90 

4x4 18.12 – 20.50 2.38 
 

12,21 -32.91 1.08 21.66 

8x8 18.18 – 20.50 2.32 
 

11,90 -33.03 1.03 28.24 

 

Tek yama anten tasarımında, başlangıçta 10,80 dBi kazanç ve 1,62 GHz (%8,22) bant 

genişliği gözlenmiştir. 1x2 dizi yapısı oluşturulduğunda ise kazanç artarak 12,55 dBi ve 

bant genişliği 2,02 GHz (%10,58) seviyelerine çıkmıştır. 2x2 yapısı oluşturulduğunda 

bant genişliği bir miktar daha artarak 2,36 GHz (%12,10) seviyesine yükselmiştir. Anten 

kazancı ise 14,90 dBi seviyesine çıkmıştır. Dizi yapısı büyütülmeye devam edilmiş ve 

4x4 yapısı oluşturulmuştur. 4x4 yapıda bant genişliği bir önceki antene kıyasla 20 MHz 

daha artarak 2,38 GHz (%12,21) seviyesine gelmiştir. Anten kazancı ise bir önceki yapıya 

kıyasla yükselerek 21,66 dBi değerine yükselmiştir. Son olarak 8x8 dizi anten 

tasarımında, antenin kazancı önemli ölçüde artırılmış 28,24 dBi seviyesine çıkmıştır. 

Bant genişliği 2,32 GHz’e (%11,90) gerilemiş ancak hedef haberleşme frekans aralığı 

olan 18-21 GHz aralığının neredeyse tamamını kapsayacak şekilde sonuçlanmıştır. 

VSWR değerleri karşılaştırıldığında ise 8x8 yapıya doğru gidildikçe azalan bir yapıya 

doğru gidildiği ve 1,03 değerinin elde edildiği görülmektedir. Bu oran duran dalga oranını 

ifade ettiğinden anten verimliliğinin sağlanabilmesi adına düşük olması tercih 

edilmektedir. Sonuç olarak 8x8 dizi anten yapısında 18,18-20,50 GHz bant genişliğinde 

haberleşme yapabilecek yüksek kazançlı anten tasarımı tamamlanmıştır. 

 

Yapılan simülasyonlar sonucunda hem Tx hem de Rx hatlarında en yüksek performansı 

sağlayan 8x8 mikroşerit anten yapısı, diğer konfigürasyonlarla karşılaştırıldığında en 

düşük VSWR değerlerine ve en yüksek kazançlara sahip olduğu için tercih edilmiştir. 8x8 

antenin gönderme hattında kazancı 24.04 dBi, alma hattında ise 28.24 dBi olarak 

ölçülmüştür. Her iki durumda da antenler geniş bant genişliği ve düşük 𝑆11 değerleri ile 

üstün performans sergilemiştir.  
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5.1.2. STK Simülasyon Sonuçları 

 

Yapılan tez çalışması kapsamında tasarlanan alma ve gönderme hatları antenlerinin 

simülasyon analizleri STK (System Tool Kit) programı kullanılarak yapılmıştır. Program 

üzerinde 41º Doğu yörüngesine yerleştirilmiş potansiyel bir GEO uydusu tanımlanmıştır. 

Uydu üzerine Ka-Bant haberleşme sistemleri ve antenleri konumlandırılmış olup link 

bütçesi analizleri kapsamında kullanılmıştır. Bu bağlamda uydu üzerine iki farklı Ka-

Bant gönderme anteni yerleştirilmiş ve uçağın uçuş rotasını kapsayacak şekilde iki farklı 

hüzme (beam) oluşturulmuştur. Uydu üzerinden Hüzme-1 240º azimut, 84º elevasyon 

açısı ile Hüzme-2 ise 295º azimut, 85º elevasyon açısı ile yönlendirildiğinde Konya – 

Barselona arası konumlarda yeterli kapsama alanına sahip olduğu görülmüştür. 

Oluşturulan çoklu hüzme görselleri Şekil 101’de belirtilmiştir. İlgili görsel incelendiğinde 

Konya ve Barselona arası tüm lokasyonlarda kapsama alanı sağlandığı görülmektedir.  

 

Benzer şekilde Konya (KON)’dan Barselona (BCN) lokasyonuna doğru seyir halinde 

olan potansiyel bir yolcu uçağı tanımlaması yapılmış olup tasarlanan 8x8 alma ve 

gönderme hatları antenleri ile haberleşme ekipmanları uçak üzerine konumlandırılmıştır. 

Alma ve gönderme hatları için uçak ve uydu tanımlamalarının yapılmasının ardından 

simülasyon gerçekleştirilmiş ve link bütçesi analizleri yapılmıştır. Oluşturulan senaryoda 

yolcu uçağı seyahat rotası boyunca GEO uyduyu takip etmiştir. Uydu takibi kapsamında 

sinyalin 5dk’lık aralıklarla yolculuk süresi boyunca azimut, elevasyon açıları ile uydunun 

uçağa göre mesafesinin değişimi Şekil 102’de verilmiştir. Buradan saat 09:00’da 

Konya’dan kalkan uçağın aldığı ilk sinyal yönünün azimutta 238,165º, elevasyonda 

45,404º olduğu ve antenin uydu ile mesafesinin 37384 km olduğu görülmektedir. 

Yolculuğun devam eden saatlerinde saat 11:00’de azimut açısının 226,666 º, elevasyon 

açısının 39,594º ve uydu mesafesinin 37812 km olduğu görülmektedir. Yolculuğun 

sonuna bakıldığında ise saat 13:02’de azimut açısının 218,205º, elevasyon açısının 

31,310º ve uydu mesafesinin 38497 km olduğu görülmektedir. Buradan da anlaşıldığı gibi 

uçağın konumunun batıya doğru değişmesi azimut ve elevasyon açılarında azalmaya 

sebebiyet vermiş olup uydu mesafesinin artışı Şekil 102’de görülmektedir.  

 

Gönderme hattı kapsamında veri iletiminin sağlanması için kullanılacak RF taşıyıcı 

parametreleri belirlenmiştir. Bu bağlamda 50 Mbps veri hızı sağlamak için QPSK 

modülasyonunda Reed-Solomon (239,255) kanal kodlama, 1/3 FEC ve %5 Roll-Off 
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değeri kullanılarak 78,75 MHz bant genişliğinde bir taşıyıcıya ihtiyaç olduğu bu tez 

kapsamında belirlenmişti. Taşıyıcı parametreleri Çizelge 6’te verilmiştir. QPSK 

modülasyonunda her sembolde iki bit taşındığından spektral verimliliği artırmaktadır. Bu 

da veri iletim hızını artırırken bant genişliğini verimli kullanmayı sağlar. QPSK, yüksek 

veri hızlarına ulaşırken kararlı bir performans sunar. Gürültü ve parazitlere karşı daha 

dirençlidir. Elbette ki QPSK modülasyonundan daha verimli modülasyon tipleri 

mevcuttur (8PSK, 16APSK vb.). Ancak modülasyon tipi artırıldıkça güç ihtiyacı da 

artacak olup maliyetler çok yükselecektir. Dolayısıyla QPSK modülasyonu enerji 

tüketimi açısından verimlidir, bu da mobil ve uzay uygulamaları için önemlidir. Ayrıca 

QPSK modülatör ve demodülatörlerin tasarımı ve uygulaması nispeten basittir, bu da 

sistem maliyetlerini düşürür. 

 

QPSK modülasyonunda bir sinyalin uydu haberleşmesi kapsamında performans 

değerlendirmelerinin standartlara uygun olarak sağlanabilmesi için belirli bir BER 

değerine ulaşması beklenmektedir. BER değeri ise sistemin elde ettiği Eb/N0 değerine 

göre değişmektedir. Bu bağlamda havacılık ve uzay haberleşme standartları ITU 

(International Telecommunication Union) uydu haberleşme sistemlerinde 10−10 BER 

değerine sahip olunması gerektiğini refere etmektedir. Yüksek güvenilirlik ve veri 

bütünlüğü gereken haberleşme sistemlerinde standart olarak bu değer kabul edilir. 10−10 

BER değeri sağlandığı takdirde hatasız veri iletimi için yeterli koşullar oluşmuş olacaktır. 

Tasarlanan anten sistemlerinin uluslararası kabul görmüş sistemlere uygun olması için 

ITU referansları baz alınmalıdır.  

 

QPSK modülasyonunda 10−10 BER değerine ulaşabilmek için tasarlanan sistemin sahip 

olması gereken en düşük Eb/N0 değeri belirlenmiştir. Bu değer MATLAB’da Bit Error 

Rate Analysis Tool üzerinden hesaplanmış olup 13,04 olarak belirlenmiştir. Anten 

sisteminin daha verimli olarak ve daha az maliyetli şekilde sağlanabilmesi ve link bütçesi 

hesaplarının da rahatlıkla sağlanabilmesi için QPSK modülasyonuna ek olarak Reed-

Solomon (239,255) kanal kodlama gerçekleştirilmiştir. Reed Solomon kodlaması, hata 

düzeltme kabiliyeti sağlamakla birlikte veri iletiminde oluşabilecek hataları düzeltir ve 

BER (Bit Error Rate) oranını düşürür. Hata düzeltme kodlaması, sistemin güvenilirliğini 

artırır ve veri bütünlüğünü korur. Bu, sinyalin zayıfladığı veya parazitlerin arttığı 

durumlarda bile veri kaybını önler. Hata düzeltme kodlamasının dezavantajı olarak ekstra 

bant genişliğine ihtiyaç duyulduğu belirtilebilir. Ancak, bu artan bant genişliği 
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gereksinimi, sağlanan hata düzeltme ve güvenilirlik avantajları ile dengelenir. Reed-

Solomon (RS) hata düzeltme kodlaması için MATLAB BER Analysis Tool üzerinden 

yapılan analizler sonucunda QPSK modülasyonu ve RS birlikte kullanıldığında 10−10 

BER değerinin elde edilebilmesi için 7,94 dB Eb/N0 değerine ihtiyaç duyulmaktadır. 

Buradan da kodlamasız değere göre 5 dB’lik bir kazanç oluştuğu görülmüştür. İlgili 

değerler Şekil 13’te gösterilmiştir.  

 

Benzer şekilde alma hattı haberleşmesi kapsamında veri iletiminin sağlanması için 

kullanılacak RF taşıyıcı parametreleri de belirlenmiştir. Bu bağlamda 100 Mbps veri hızı 

sağlamak için QPSK modülasyonunda Reed-Solomon (239,255) kanal kodlama, 8/9 FEC 

ve %5 Roll-Off değeri kullanılarak 59,0625 MHz bant genişliğinde bir taşıyıcıya ihtiyaç 

olduğu bu tez kapsamında belirlenmişti. Gönderme anteninde olduğu gibi alma anteninde 

de QPSK modülasyonu ve RS birlikte kullanıldığında 10−10 BER değerinin elde 

edilebilmesi için 7,94 dB Eb/N0 değerine ihtiyaç duyulmaktadır. Taşıyıcı parametreleri 

Çizelge 5’te verilmiştir. 

 

Alma ve gönderme hatları kapsamında link bütçesine girdi oluşturacak tüm parametreler 

belirlendikten sonra link bütçesi analizleri işlemleri gerçekleştirilmiştir. Link bütçesi 

analizlerinde EIRP (Effective Isotropic Radiated Power), G/T (Gain-to-Noise 

Temperature Ratio), C/N0 (Carrier-to-Noise Density), bant genişliği, C/N (Carrier-to-

Noise Ratio), Eb/N0 (Energy per Bit to Noise Power Density Ratio) ve BER (Bit Error 

Rate) değerleri hesaplanmış ve performans değerlendirmeleri yapılmıştır.  

 

Alma hattı link bütçesi analizlerinde uydu tarafında 46,77 dBW EIRP, yolcu uçağı 

üzerindeki anten sisteminin G/T değeri 28,44 dB/K olarak hesaplanırken 100 Mbps veri 

hızı için 59,0625 MHz taşıyıcıya ihtiyaç duyulacağı belirlenmiştir. Yolcu uçağı ve uydu 

arasında haberleşmenin başladığı andan bitimine kadar 5 dakikalık aralıklarla alınmış link 

bütçesi analiz sonuçları Şekil 105 ve Şekil 106’de gösterilmiştir. Haberleşmenin ilk, orta ve 

son alınan parametreleri Çizelge 11’da gösterilmiştir.  
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Çizelge 11: Alma Hattı Link Bütçesi Karşılaştırma Çizelgesi 

 

Saat C/N0 (dB/Hz) C/N (dB) Eb/N0 (dB) BER 

09:00 94,11 16,39 13,69 3,81E-12 

11:00 94,01 16,29 13,59 6,54E-12 

13:00 93,86 16,14 13,44 1,46E-11 

 

Çizelgeden da görüldüğü üzere C/N0, C/N ve Eb/N0 değerlerinde haberleşmenin 

sağlandığı ilk andan son ana kadar yaklaşık 0,25 dB her birinde azalma meydana 

gelmiştir. Bu azalmaların sebepleri olarak uydu mesafesinin artması sebebiyle sinyal 

seviyesindeki azalmalar ve uydu kapsama alanının yolculuk süresi boyunda kazanç 

değerlerinin değişken olması söylenebilir. Bu azalmalara rağmen alınan Eb/N0 değerleri 

teorik gerekli Eb/N0 değeri olan 7,94 dB’den oldukça yukarıda olduğundan 

haberleşmenin sağlanacağını yorumlayabiliyoruz. Benzer şekilde BER değeri de ilk anda 

3,81𝑥10−12 iken son anda 1,46𝑥10−11seviyesine düşmüştür. Buna rağmen yolculuğun 

başından sonuna kadar 10−11 BER değerinin altına inmemiştir. Bu da haberleşme 

performansını yeterli seviyede sağladığını göstermektedir.  

 

Gönderme hattı link bütçesi analizlerinde uçak tarafında 51,04 dBW EIRP, uydu 

üzerindeki anten sisteminin G/T değeri 27,96 dB/K olarak belirlenirken 50 Mbps veri hızı 

için 78,75 MHz taşıyıcıya ihtiyaç duyulacağı belirlenmiştir. Yolcu uçağı ve uydu arasında 

haberleşmenin başladığı andan bitimine kadar 5 dakikalık aralıklarla alınmış link bütçesi 

analiz sonuçları 
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Çizelge 7 ve Çizelge 8’da gösterilmiştir. Haberleşmenin ilk, orta ve son anında alınan 

parametreleri Çizelge 12’da gösterilmiştir.  

 
Çizelge 12:Gönderme Hattı Link Bütçesi Karşılaştırma Çizelgesi 

 

Saat C/N0 (dB/Hz) C/N (dB) Eb/N0 (dB) BER 

09:00 97,92 18,96 20,93 1E-30 

11:00 97,82 18,86 20,83 1E-30 

13:00 97,67 18,71 20,68 1E-30 

 

Çizelgeden da görüldüğü üzere C/N0, C/N ve Eb/N0 değerlerinde haberleşmenin 

sağlandığı ilk andan son ana kadar yaklaşık 0,25 dB her birinde azalma meydana 

gelmiştir. Bu azalmaların sebepleri olarak uydu mesafesinin artması sebebiyle sinyal 

seviyesindeki azalmalar ve uydu kapsama alanının yolculuk süresi boyunda kazanç 

değerlerinin değişken olması söylenebilir. Bu azalmalara rağmen alınan Eb/N0 değerleri 

teorik gerekli Eb/N0 değeri olan 7,94 dB’den oldukça yukarıda olduğundan 

haberleşmenin sağlanacağını yorumlayabiliyoruz. Benzer şekilde BER değeri de ilk 

andan son ana kadar  1𝑥10−30 değerinin altına inmemiştir. Bu da haberleşme 

performansını fazlasıyla yeterli seviyede sağladığını göstermektedir.  
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 Yapılan simülasyonlar, tasarlanan antenlerin teorik performanslarının gerçek kullanım 

senaryolarında nasıl sonuçlar verdiğini göstermiştir. Simülasyonlar, GEO uydu ile yolcu 

uçağı arasındaki haberleşmenin sürekliliği ve kapsama alanı açısından olumlu sonuçlar 

vermiştir. Konya (KON) ile Barselona (BCN) arasındaki uçuş rotasında kesintisiz 

haberleşme sağlanmıştır. Bu, antenlerin gerçek zamanlı uçuş şartlarında etkin bir şekilde 

çalışabileceğini göstermektedir. 

 

 

5.2.  Öneriler 

 

Bu çalışmanın sonuçlarına dayanarak, gelecekteki araştırmalar ve uygulamalar için bazı 

öneriler geliştirilmiştir. Anten tasarımında iyileştirmeler yapılabilir. Mikroşerit anten 

tasarımında kullanılan Rogers RT Duroid 5880 malzemesi, düşük dielektrik kaybı ve 

yüksek frekans stabilitesi ile ön plana çıkmaktadır. Bu malzeme, yüksek performanslı RF 

ve mikrodalga uygulamaları için idealdir. Ancak, maliyet açısından diğer dielektrik 

malzemelere göre daha pahalı olabilir. Alternatif olarak, yüksek iletkenliğe sahip ve daha 

düşük maliyetli malzemeler araştırılabilir. Tasarımın optimizasyonu, besleme hattı 

tasarımı ve anten geometrisi üzerinde yapılan ince ayarlar ile performans daha da 

artırılabilir. Besleme hattı tasarımı ve anten geometrisi optimize edilerek anten 

performansı artırılabilir. Örnek olarak Şekil 107’da belirtildiği gibi mikroşerit besleme 

yöntemi ile 8x8 dizi anten tasarımı için besleme hattı yapısı kurulabilir. Mikroşerit 

besleme yöntemi üretim, uygulama kolaylıkları ve düşük bütçeli olması gibi sebeplerden 

dolayı tercih edilebilir (Borgarino, 2010).  
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Şekil 107: 8x8 Dizi Anten Tasarımı İçin Örnek Besleme Hattı Tasarımı 

 

Havacılık uygulamalarında, uçaklarda internet erişimi sağlamak için mikroşerit 

antenlerin kullanılması, daha güçlü ve kesintisiz iletişim sağlayacaktır. Bu sektör için 

antenlerin düşük profilli ve hafif olması önemlidir. Uydu haberleşmesinde ise geniş 

coğrafi alanlara etkili hizmet sağlamak için yüksek kazançlı mikroşerit antenlerin 

kullanılması önerilmektedir. Bu tür antenler, uydu haberleşmesinde daha verimli veri 

iletimi sağlayabilmektedir. 

 

Farklı anten dizisi konfigürasyonları ile daha detaylı analizler yapılabilir. Bu, belirli 

uygulamalar için en uygun konfigürasyonun belirlenmesine yardımcı olabilir. Ayrıca 

diğer yüksek frekans bantlarında da benzer analizler yapılarak farklı iletişim ihtiyaçlarına 

yönelik çözümler sunulabilir. Modern simülasyon ve optimizasyon tekniklerinin 

kullanılması, anten tasarım sürecinde yeni fırsatlar sunabilir. Özellikle yapay zekâ ve 

makine öğrenimi tekniklerinin entegrasyonu ile daha kapsamlı analizler yapılabilir. 

 

Mikroşerit antenlerin 5G ve IoT uygulamalarında kullanımı, bu teknolojilerde yüksek 

veri iletim kapasitesi ve düşük gecikme süreleri sunması nedeniyle önemlidir. Mikroşerit 

antenlerin faz dizinli yapısı, yönlendirilebilirlik ve yüksek kazanç sağlaması açısından 

avantajlıdır. Işın yönlendirme yetenekleri ile çeşitli uygulamalarda esneklik sunar. Ancak, 

daha karmaşık bir tasarım ve kontrol mekanizması gerektirmesi ve maliyetlerin artması 

dezavantajları arasında yer alır. 
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QPSK modülasyon tipi, yüksek veri iletim hızları ve spektrum verimliliği sağlaması 

nedeniyle tercih edilmiştir. Reed-Solomon kodlama ise hata düzeltme yetenekleri sunarak 

iletişim güvenilirliğini artırır. Bu kombinasyon, veri iletimindeki hataların azaltılmasını 

sağlar. Seçilen FEC değeri, iletişim sisteminin hata düzeltme kapasitesini artırarak BER'i 

(Bit Error Rate) iyileştirir. %5 roll-off değeri, spektrum verimliliği ve sinyal kalitesi 

arasında bir denge sağlar. Farklı roll-off değerleri, spektrum genişliği ve sinyal kalitesi 

üzerinde farklı etkiler yaratabilir. 

 

STK simülasyonlarında uçak gibi hareketli platformlar için daha gerçekçi simülasyon 

senaryoları oluşturulabilir. Bu senaryolar, farklı uçuş rotaları ve hava koşulları gibi 

değişkenleri içerebilir. Ayrıca antenlerin farklı uçuş dinamiklerinde performansını 

değerlendiren simülasyonlar yapılabilir. 

 

Uydu üzerinden internet haberleşmesi kapsamında birden fazla uçakta aynı anda 

kullanılan anten sistemlerinin performansını değerlendiren simülasyonlar 

gerçekleştirilebilir. Bu, sistemin geniş ölçekli uygulanabilirliğini test etmek açısından 

önemli olacaktır. 

 

Tasarlanan antenlerin prototip üretimi yapılarak, gerçek ortamda performans testleri 

gerçekleştirilebilir. Bu testler, laboratuvar ortamında yapılan simülasyonların gerçek 

dünyadaki geçerliliğini ortaya koyacaktır. Ayrıca antenlerin uçak üzerindeki aerodinamik 

etkileri de incelenebilir. 

 

Uçuş sırasında gerçek zamanlı performans testleri yapılarak, antenlerin dinamik 

koşullardaki performansı değerlendirilebilir. Bu testler hem antenlerin dayanıklılığını 

hem de sürekli haberleşme kapasitesini ortaya koyacaktır. 

 

Bu öneriler hem akademik araştırmalar hem de endüstriyel uygulamalar için yol gösterici 

nitelikte olup, hava taşımacılığında daha etkin ve güvenilir haberleşme sistemlerinin 

geliştirilmesine katkı sağlayacaktır. Gelecekte yapılacak çalışmalar, bu tezde elde edilen 

sonuçların daha da ileriye taşınmasına olanak sağlayacaktır. 
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EKLER  

 

EK-1 QPSK (Kodlamasız) ve QPSK (Reed-Solomon (239,255)) kodlamalı Modülasyon 

Tipleri için Teorik Eb/N0 Hesaplamaları MATLAB Kodları  

 

% Parameters 

M = 4; % Modulation order for QPSK 

k = log2(M); % Bits per symbol 

n = 1e5; % Number of bits to process 

EbNo = 0:2:14; % Eb/No range 

berNoCoding = zeros(size(EbNo)); % BER results without coding 

berWithRS = zeros(size(EbNo)); % BER results with RS coding 

 

% Reed-Solomon parameters 

nRS = 255; % Codeword length 

kRS = 239; % Message length 

rsEnc = comm.RSEncoder(nRS, kRS, 'BitInput', true); 

rsDec = comm.RSDecoder(nRS, kRS, 'BitInput', true); 

 

% Simulation loop for uncoded QPSK 

for i = 1:length(EbNo) 

    numBits = 0; 

    numErrs = 0; 

    while numBits < n 

        % Generate random bits 

        dataIn = randi([0 1], n, 1); 

         

        % Modulate using QPSK 

        txSig = qammod(dataIn, M, 'InputType', 'bit', 'UnitAveragePower', true); 

         

        % Pass through AWGN channel 

        rxSig = awgn(txSig, EbNo(i) + 10*log10(k), 'measured'); 

         

        % Demodulate 

        dataOut = qamdemod(rxSig, M, 'OutputType', 'bit', 'UnitAveragePower', true); 
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        % Calculate BER 

        [numErrsThisIteration, ~] = biterr(dataIn, dataOut); 

        numErrs = numErrs + numErrsThisIteration; 

        numBits = numBits + n; 

    end 

    berNoCoding(i) = numErrs / numBits; 

end 

 

% Simulation loop for QPSK with Reed-Solomon coding 

for i = 1:length(EbNo) 

    numBits = 0; 

    numErrs = 0; 

    while numBits < n 

        % Generate random bits 

        dataIn = randi([0 1], kRS*8, 1); 

         

        % RS encode 

        encodedData = rsEnc(dataIn); 

         

        % Modulate using QPSK 

        txSig = qammod(encodedData, M, 'InputType', 'bit', 'UnitAveragePower', true); 

         

        % Pass through AWGN channel 

        rxSig = awgn(txSig, EbNo(i) + 10*log10(k), 'measured'); 

         

        % Demodulate 

        dataOut = qamdemod(rxSig, M, 'OutputType', 'bit', 'UnitAveragePower', true); 

         

        % RS decode 

        decodedData = rsDec(dataOut); 

         

        % Calculate BER 

        [numErrsThisIteration, ~] = biterr(dataIn, decodedData(1:length(dataIn))); 
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        numErrs = numErrs + numErrsThisIteration; 

        numBits = numBits + length(dataIn); 

    end 

    berWithRS(i) = numErrs / numBits; 

end 

 

% Plot results 

semilogy(EbNo, berNoCoding, 'o-', 'DisplayName', 'Uncoded QPSK'); 

hold on; 

semilogy(EbNo, berWithRS, 's-', 'DisplayName', 'QPSK with RS(239,255)'); 

grid on; 

xlabel('Eb/No (dB)'); 

ylabel('Bit Error Rate'); 

title('BER vs. Eb/No for QPSK with and without Reed-Solomon Coding'); 

legend; 

hold off; 

 

% Interpolate to find the Eb/No value for BER = 10^-10 

targetBER = 1e-10; 

 

% Ensure the EbNo and BER values are unique and sorted for interpolation 

[uniqueBerNoCoding, uniqueIdxNoCoding] = unique(berNoCoding); 

uniqueEbNoNoCoding = EbNo(uniqueIdxNoCoding); 

 

[uniqueBerWithRS, uniqueIdxWithRS] = unique(berWithRS); 

uniqueEbNoWithRS = EbNo(uniqueIdxWithRS); 

 

EbNoForTargetBER_NoCoding = interp1(uniqueBerNoCoding, uniqueEbNoNoCoding, 

targetBER, 'linear', 'extrap'); 

EbNoForTargetBER_WithRS = interp1(uniqueBerWithRS, uniqueEbNoWithRS, 

targetBER, 'linear', 'extrap'); 

 

fprintf('Eb/No required for BER of 10^-10 (Uncoded QPSK): %.2f dB\n', 

EbNoForTargetBER_NoCoding); 
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fprintf('Eb/No required for BER of 10^-10 (QPSK with RS(239,255)): %.2f dB\n', 

EbNoForTargetBER_WithRS); 
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EK-2 Atmosferik Kayıp Hesaplamaları için MATLAB Kodları 

 

maps = exist('maps.mat','file'); 

p836 = exist('p836.mat','file'); 

p837 = exist('p837.mat','file'); 

p840 = exist('p840.mat','file'); 

matFiles = [maps p836 p837 p840]; 

if ~all(matFiles) 

    if ~exist('ITURDigitalMaps.tar.gz','file') 

        url = 'https://www.mathworks.com/supportfiles/spc/P618/ITURDigitalMaps.tar.gz'; 

        websave('ITURDigitalMaps.tar.gz',url); 

        untar('ITURDigitalMaps.tar.gz'); 

    else 

        untar('ITURDigitalMaps.tar.gz'); 

    end 

    addpath(cd); 

end 

cfg = p618Config; 

cfg.Frequency = 19.49e9;     % Signal frequency in Hz 

cfg.ElevationAngle = 45; 

cfg.Latitude = 39.92;        % North direction 

cfg.Longitude = 32.86;      % East direction 

cfg.TotalAnnualExceedance = 0.001;  % Time percentage of excess for the total  

                % Attenuation per annum 

cfg.AntennaEfficiency = 0.65; 

disp(cfg); 

 

[pl,xpd,tsky] =  p618PropagationLosses(cfg, ... 

        'StationHeight',7.5, ... 

        'WaterVaporDensity',2.8, ... 

        'TotalColumnarContent',1.4, ... 

        'RainRate',42.0) 
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